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Sammendrag

Det er rapportert at den grenne krakebollen, Strongylocentrotus droebachiensis, kan rammes
av symptomer som har gitt navn til sykdommen kalt «skallet krakebollesyndrom». Imidlertid
er ingen patogener for krakeboller kjent i litteraturen, men det er dannet en arbeidshypotese om
at arter tilhgrende Vibrio splendidus klade kan assosieres med symptomer karakterisert som

skallet krakebollesyndrom hos arten S. droebachiensis.

Undersgkelser ved hjelp av 16S rRNA-sekvensering i denne oppgaven viser tilstedeveerelse av
arter tilhgrende V. splendidus klade hos bade friske og syke S. droebachiensis. Da
gensekvensering viste seg  veare en tidkrevende, kostbar og upalitelig metode for & identifisere
Vibrio-bakterier pa artsniva, ble det utviklet en MALDI-TOF MS database for raskere og
enklere identifisering av bestemte Vibrio-arter. | tillegg ble det utfert neermere analyse med
helgenomsekvensering pa noen av de V. splendidus-relaterte-isolatene isoler fra syke S.
droebachiensis. Virulensfaktorer som OmpU, vsm, flagell og hemolytisk aktivitet ble funnet
hos isolatene, men et eksperimentelt, lite smitteforsgk kunne likevel ikke verifisere

arbeidshypotesen. Ytterligere forsgk bgr derfor utferes.






Summary

It has been reported that the green sea urchin, Strongylocentrotus droebachiensis, can be
affected by symptoms that is associated with the disease called “bald sea urchin disease”.
However, no pathogen for sea urchins are known in the literature, but a working hypothesis
claims that species of the Vibrio splendidus clade can be associated with symptoms

characterized as bald sea urchin disease in S. droebachiensis.

With use of 16S rRNA sequencing, it is shown in this study that species belonging to the V.
splendidus clade are present in both healthy and diseased S. droebachiensis. As gene
sequencing proved to be a time consuming, costly and unreliable method for identifying Vibrio
bacteria at species level, a MALDI-TOF MS database was developed for easier and faster
identification of certain Vibrio species. In addition, further analysis was performed with whole
genome sequencing on some of the V. splendidus related isolates from diseased S.
droebachiensis. Virulence factors such as OmpU, vsm, flagellum and hemolytic activity were
found in the isolates, but still a small challenge experiment could not verify the working
hypothesis.
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Forkortelser

AMP — Antimikrobiell peptid

Bp — Base par

CF — Coelomvaske/Coelomic fluid
CFU — Colony forming units

DNA — Deoxyribonucleic Acid

FMAP — Fortynnet Marin Agar Pepton
MALDI-TOF - Matrix-assisted laser desorption ionization time-of-flight
MS — Massespektrometri

m/z — Masse/ladnings ratio

OD — Optisk tetthet

OmpU — Outer membrane protein U
PBS — Fosfatbuffer med salt

PCR — Polymerase chain reaction

PM — Peristomal membrane

recA — Recombination Protein A

RNA — Ribonucleic Acid

TAE — Tris-Acetate-EDTA

TP/TL — Test part/Test lesion/Overflate

Vsm — Extracellular zinc metalloprotease
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1 Innledning

Det mikrobielle livet eksisterer pa alle omrader og alle steder i vart naturlige milja. | det daglige
liv lever vi som regel i harmoni med mikrobene, men noen mikroorganismer er patogene og
kan forarsake problemer bade for helsen var og for vare oppdrettsprodukter. For eksempel
antyder estimering av de gkonomiske tapene i akvakulturen av fisk, at Japan mistet minst 16,4
millioner amerikanske dollar i 2004 alene pa grunn av sykdomsfremkallende mikrober [1]. |
akvakulturen av andre marine organismer, som for eksempel i oppdrettsneeringen av krake-
boller nord i Kina, har ogsa sykdomsfremkallende mikroorganismer veert arsaken til store
gkonomiske tap [2]. Taksonomiske og fylogenetiske undersgkelser pa marine mikrober er
derfor sveert viktig, da kunnskap om patogene agens kan lgse noen utfordringer knyttet til
sykdom i akvakulturen [3].

1.1 Akvakultur og Kochs postulater

Akvakulturen utgjer et stort bidrag til produksjonen av mat i mange deler av verden. | Norge
kjenner vi godt til oppdrett av laks, som utgjer omtrent 1,3 millioner tonn matfisk i aret til en
farstehandsverdi pa ca. 44,3 milliarder kroner (2015) [4]. Pa grunn av akvakulturens omfang
og betydning for kloden var, ma akvakulturen veere berekraftig bade miljgmessig og
gkonomisk. Det er dermed et stort fokus pa sykdomsforebygging for & redusere tap, og i
henhold til det miljgmessige perspektivet med en redusert bruk av antibiotika. Vaksinasjon er
derfor i dag den viktigste metoden for sykdomsforebygging i akvakulturen, og den er

avgjerende for en videreutvikling av en barekraftig nering [5].

For sykdomsforebygging i akvakulturen er det ngdvendig & konstatere hvilke smitteagens som
forarsaker sykdom hos aktuell oppdrettsorganisme. For a fastsla at en mikroorganisme er arsak
til en gitt sykdom, ma et sett av kriterier vaere oppfylt. Disse er navngitt Kochs postulater, og
lyder som falger; (I) mikroorganismen skal kunne isoleres og fremstilles i renkultur i alle
sykdomstilfeller, (11) mikroorganismen skal ikke forekomme ved andre sykdommer, (111) den
isolerte mikroorganismen ma vere i stand til & fremkalle sykdommen hos forsgksdyr, og (IV)
mikroorganismen ma kunne re-isoleres fra forsgksdyrene [6]. Et av mange eksempler pa en
mikroorganisme som ved Kochs postulater er konstatert a vaere patogen for laks, er den Gram-

positive bakterien Rhodococcus erythropolis [7].
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Selv om oppdrett pa laks utgjer en av de stgrste neringene i akvakulturen, inkluderer likevel
akvakulturen blant annet produksjon av flere fiskearter, krepsdyr, alger, skjell og krakeboller.
For eksempel var Troms Krakebolle AS et firma i Norge som drev opprett pa krakeboller, med
et landbasert klekkeri pa Skittenelv, Tromsg, og en sjgbasert avdeling i Karvika, Tromsg [8]. |
vesten generelt er oppdrett pa krakeboller er en relativt ny neering, slik at forskning pa denne
organismenes immunsystem er viktig for & gke kunnskap om organismen [9]. I henhold til
litteraturen er det heller ikke definert noen patogene bakterier hos krakeboller, slik at derfor,
om det eksisterer et slik patogent agens, vil det veere viktig & fa avdekket og karakterisert det
[9, 10].

1.2 Krékeboller

Krakeboller er marine virvellgse dyr som tilhgrer klassen sjgpiggsvin (Echinoidea). De er
allestedsnarveerende organismer som finnes i alle verdenshavene og i de fleste marine habitat.
Til tross for deres tilstedeveerelse i nesten alle marine gkosystem kan en finne de fleste
krakebolleartene i tempererte eller tropiske kystomrader, mellom overflaten og ned til noen
titalls meter dyp [11]. Dette fordi de i hovedsak lever av fotosyntetiserende alger, selv om de
ogsa kan livnere seg pa andre virvellgse dyr som for eksempel blaskjell, barstemark, svamper
og slangestjerner [12]. Vi mennesker har i relativt lang tid benyttet krakeboller til mat, og i de
siste tidrene har dyrkning av krakeboller blitt en voksende industri. 16 krakebollearter har til na
bidratt til den marine matproduksjonen, selv om det er registrert omtrent 1000 arter av
krakeboller i verden [13, 14].

1.2.1 Krakebollens anatomi

Gonadene til krakebollene, som ofte omtales som rogn, er det vi mennesker konsumerer. De
kan se ut som sma mandarinbater som er lokalisert pa innsiden av krakebollens globulere
kropp, mellom fem band av porer pa det indre skjelettet/skallet. Bandene av porer strekker seg
fra munnen pa undersiden av kroppen til anus pa oversiden av kroppen, og lager et stjerne-
menster pa krakebollens overflate. Ut i fra porene stikker det frem slanke, knappenalformede
og utvidbare sugefatter, som benyttes bade som bevegelsesorgan og sanseorgan. | tillegg til
sugefotter er overflaten til krakebollene dekket av sensoriske, bevegelige og beskyttende
pigger, som hos noen arter kan inneholde gift. Rundt munnapningen til krakebollen er det ikke

tilstedeveerelse av pigger, men en myk membran kalt for peristomal membran (PM). Denne
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membranen ligger rundt et komplekst tannsystem som krakebollen benytter for konsum av mat
eller til & grave seg gjemmesteder i koraller og steiner. Det som skiller krakeboller i fra andre
pigghuder er organismens store, interne hulrom kalt coelomic hulrom eller coelom. Dette
hulrommet huser gonadene, fordgyelsessystemet, samt resten av krakebollens organer, og er
fylt med coelomvaske (coelomic fluid; CF). Coelomvasken utgjer krakebollens vaskulare
system, og har mange av de samme funksjonene som blodet har hos pattedyr. Blant annet
inneholder den ulike celletyper som bade utgjer organismens immunologiske forsvars-
mekanisme, samt brukes til transport av nearingsstoffer og avfallsstoffer. I figur 1 illustreres

den beskrevne anatomien til en krakebolle. [9, 15, 16]

Ampullae Peristomal Teeth
membrane

Figur 1: Illustrasjon av anatomien til en Krakebolle. Skisse: Solveig Bentdal

1.2.2 Krakebollens forsvarssystem

I mange ar ble det medfadte immunsystemet til echinoderms betraktet som en simpel form for
immunsystem. | nyere undersgkelser pa immunsystemet til organismen [17-20], samt ved
publikasjonen av genomet til Strongylocentrotus purpuratus [21], har det derimot kommet frem

at krakeboller har et mer komplekst medfadt immunsystem enn tidligere antatt.



Coelomvaesken til krakebollen utgjer organismens medfadte immunsystem, og bestar av blant
annet coelomocytter (se figur 2). Disse kan sammenlignes med humane blodceller, og kan deles
inn i fire subklasser: fagocytter, vibratile celler, fargelgse sferocytter og rgde sfeerocytter [22-
26]. | tillegg til coelomocyttene bestar immunsystemet til krakebollen av flere immun-
reseptorer, en form for komplementsystem og mange antimikrobielle peptider (AMPs) [27].
Eksempel pa AMPs isolert av Li et al. hos den grenne krakebollen, S. droebachiensis, er

strongylocins og centrocin [28, 29].

o

Fagocytt Vibratil celle  Fargelgs sfeerocytt Rad sfeerocytt

Figur 2: lllustrasjon over coelomocyttene til krakeboller.

1.3 Strongylocentrotus droebachiensis

Langs norskekysten er S. droebachiensis, ogsa kalt grann krakebolle eller Drgbakkrakebolle,
en av de vanligste krakebolleartene (figur 3) [30]. Denne arten er den mest utbredte arten i
familien Strongylocentrotidae [31], og den finnes pa den nordlige halvkule i omrader med kaldt
vann [32, 33]. Den lever pa alle slags typer underlag fra 0 til 300 meters dybde, men trives best
pa steingrunn fra O til 50 meters dybde [32]. S. droebachiensis har evnen til & justere sin
metabolisme og sitt aktivitetsniva etter sesongmessige variasjoner i havtemperaturen, som kan
variere fra -1 til 20 °C i lgpet av et ar [34]. Arten er ikke i stand til & vokse eller utvikle seg

normalt om temperaturen overstiger 10 °C [35].

Tilgangen pa nearing er ogsa en viktig faktor i forbindelse med vekst hos den grgnne
krakebollen. Dette begrunnes med at bestander som er funnet pd nearingsfattige omrader
hovedsakelig bestar av sma individer med hgy dadelighet, mens bestander som er funnet pa
naringsrike omrader bestar av sterre individer [36-38]. Det er dermed vanskelig a fastsla
alderen til en grenn krakebolle pa bakgrunn av kroppsstarrelsen. 1 likhet med andre krake-
bollearter er ogsa den grenne krakebollen en alteter, med matpreferanser som pavirkes sterkt
av miljgfaktorer som temperatur, bunntopografi, balger, konkurranse og predasjon [33, 39].
4



Imidlertid er det rapportert at familien Strongylocentrotidae foretrekker store, dominerende
algearter som for eksempel Saccharina longicruris og Laminaria digitata [40], og pa bakgrunn
av dette har S. droebachiensis en viktig gkologisk rolle i forhold til distribusjonen og mengden
av makroalger i et marint milje. | Norge har arten i lang tid blitt betraktet som en pest, serlig i
omrader hvor taren har vert viktig for andre kommersielle arter, og det er ikke far i nyere tid
at krakebollen har blitt ansett som en verdifull handelsvare [41]. Det bedrives derfor i dag

oppdrett pa krakebollen flere steder i Norge, men bare i smaskala [42].

Figur 3: Fotografi av S. droebachiensis, grenn krakebolle, i sjgvann. Foto: Solveig Bentdal

1.4 Sykdom hos krakeboller

Siden begynnelsen av 20-tallet har det blitt rapportert om forskjellige typer sykdom hos flere
ulike krakebollearter. Blant annet har det blitt rapportert om noen store utbrudd som har fart til
massedad av for eksempel Diadema antillarum i Det karibiske hav i 1983 og 1984 [43, 44],
samt S. droebachiensis i Nova Scotia mellom 1980 og 1983 [45], med tilbakevendende utbrudd
i 1993 og 1995 [46]. | tillegg har det blitt rapportert om flere mindre sykdomsutbrudd hos

krakeboller rundt om i alle verdenshavene [10].

Hva som forarsaker sykdom hos krakebollene er i mange tilfeller uklart. Dette fordi det i flere
tidligere studier ikke er avklart sykdomsfremkallende agens eller egenskaper til mistenkte

agens, samt at symptomene til krakebollene er darlig beskrevet [10]. Imidlertid har bade
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bakterier, sopp, parasitter og til og med alger blitt vurdert og ansett som patogener [47]. For
eksempel er det flere rapporter som bekrefter parasittangrep som har fart til alvorlige skader pa
krakebollen S. droebachiensis [41]. Likevel er bakterier antatt & veere den viktigste arsaken til
sykdom i de fleste rapporterte tilfellene av krakebollesykdom. Eksempel pa bakterier som er
isolert og studert i forbindelse med krakebollesykdom er Vibrio [48, 49], Flavobacterium [50],
Pseudomonas[50], Aeromonas[48], Acinetobacter[51], Alcaligenes[51] og Pseudoalteromonas
[52].

1.4.1 Skallet krakebollesyndrom

Den mest rapporterte krakebollesykdommen pa begge sider av Nord-Atlanteren, samt i det
nordastlige Stillehavet, er sykdommen kalt for «skallet krakebollesyndrom» (bald sea urchin
disease). Syndromet ble farst oppdaget i California i 1970 [50], og har siden 1978 blitt registrert
i Middelhavet [53]. Den forekommer i flere ulike arter, der i blant S. droebachiensis, og den
har fatt navnet sitt etter ett av symptomene. Dette symptomet er skallethet, som vil si tap av
pigger og sugefetter pa deler av kroppsoverflaten. I tillegg til skallethet oppstar det
karakteristiske lesjoner av et mgrkt, glinsende vev/belegg pad skadeomradet (se figur 4).
Innenfor dette beltet av svullent, markt vev kan en finne det indre skjelettet helt blottlagt eller
eventuelt dekket av et grgnnfarget, nevrotisk epidermalvev [10]. Lesjonene kan med tiden
forsvinne eller de kan resultere i perforering av det indre skjelettet. Med andre ord kan
sykdommen vere dgdelig, og det er blitt rapportert om massedgd av krakebolleartene S.
franciscanus i California og S. droebachiensis i Nova Scotia pa grunn av skallet
krakebollesyndrom [54, 55].

Figur 4: Fotografi av tre ulike granne krakeboller med skallet krakebollesyndrom. Alle tre krakebollene
har dannelse av en mark, radlig lesjon pa overflaten, i tillegg til tap av pigger og sugefatter i omradet
med lesjondannelse. Foto: Jonathan Hira



Arsaken til skallet krékebollesyndrom er per i dag uklar, men sykdommen er i flere studier
antatt & veere forarsaket av bakterier. Dette pastas selv om det i mange av tilfellene ikke er blitt
identifisert noen spesifikk patogen bakterie [10]. Likevel bgr det nevnes at Gilles og Pearse i
1986 isolerte bakterier fra lesjoner pa syke S. purpuratus, og konkluderte med at isolatene
Vibrio anguillarum og Aeromonas salmonicida kunne vere arsak til lesjondannelse [48]. |
tillegg identifiserte Roberts-Regan et al. i 1988 85 bakterieisolater fra S. droebachiensis med
og uten lesjon, og konkluderte med at det totale antallet mikroorganismer, samt antallet av
bakteriene Acinetobacter og Alcaligenes var signifikant hgyere pa kroppsoverflaten til krake-
bollene med lesjon (syk) enn pa krakebollene uten lesjon (frisk) [51]. Imidlertid ble bakteriene
ved begge studiene identifisert basert pa morfologiske undersgkelser og biokjemiske tester, som

for eksempel Analytical Profile Index (API) tester.

1.5 Marine bakterier

Marine bakterier kan en finne i alle marine habitater. Blant annet kan en finne de fritt suspendert
i vannet, pd sma og store partikler, i sedimenter, samt pa overflaten eller inne i kroppen og
cellene til andre organismer [56]. Nar det er sagt er det kun et fatall (<1%) av de marine
bakteriene som kan dyrkes frem og visuelt studeres [57]. Trolig er derfor ikke det sterste mang-
foldet av marine bakterier per i dag identifisert og studert. Likevel er det utviklet flere metoder
for & identifisere udyrkbare bakterier [57]. | figur 5 illustreres noen eksempler pd metoder

benyttet for & identifisere dyrkbare og udyrkbare bakterier.
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Figur 5: Eksempler pa ulike tilnzerminger for identifikasjon av dyrkbare og udyrkbare bakterier.

1.5.1 Vibrio splendidus klade

Familien Vibrionaceae innenfor klassen y-proteobacteria inkluderer de marine bakterie-
slektene Aliivibrio, Echinimonas, Enterovibrio, Grimontia, Photobacterium, Salinivibrio og
Vibrio [58]. Bakteriene i denne familien er Gram-negative bakterier, som for det meste fremstar
som stavformede, buede celler med en eneste flagell (se figur 6) [59], samt med hvitaktig,
runde, sma eller middels store kolonier. Vibrio er den starste slekten, da den bestar av mer enn
90 arter fordelt over flere klader [58, 60]. Enkelte av disse artene er humanpatogene bakterier,
og flere av artene er kjent for a veere sykdomsfremkallende for ulike marine dyr [59]. Blant
annet er V. splendidus klade en gruppe av nart beslektede arter som kan veere patogen for ulike

marine organismer, som for eksempel gsters, sjgpalse, blekksprut og fisk [61-64].
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Dartmouth Electron Microscope Facility/Louisa Howard Vibrio cholerae

Figur 6: SEM-bilde av V. cholerae. Bakterien har en buet, stavformet celle med en fluktuerende
overflate og eneste flagell. Foto: Louisa Howard

V. splendidus klade omfatter 17 naert beslektede bakteriearter [65], og disse er listet opp i tabell
1. Artene er allestedsnaerveerende i akvatiske gkosystemer, inkludert brakkvannsomrader, apne
kystfarvann, i sedimenter og i akvakulturnaringen over hele verden [66]. I tillegg er de funnet

i stor tetthet pa overflaten eller i tarmfloraen hos marine dyr [67].

Flere av medlemmene i V. splendidus klade har hemolytisk aktivitet, som betyr at de enten
produserer et toksin som lyserer blodceller eller hydrogenperoksid som omdanner hemoglobin
til methemoglobin. 1 tillegg har flere relativt lik 16S rRNA-gensekvens, i kombinasjon med hgy
sekvenslikhet av andre genetiske markgrer. Det har dermed vist seg a veere vanskelig &

identifisere og klassifisere de ulike artene i gruppen fra hverandre [68].



Tabell 1: De 17 bakterieartene i V. splendidus kladen. Navn pa art, samt referanse pa hvem som oppdaget

arten er listet opp i tabellen.

Bakterieart

Referanse:

Vibrio artabrorum
Vibrio atlanticus
Vibrio celticus
Vibrio chagasii
Vibrio crassostreae
Vibrio cyclitrophicus
Vibrio fortis

Vibrio gallaecicus
Vibrio gigantis
Vibrio hemicentroti
Vibrio kanaloae
Vibrio lentus
Vibrio pelagius
Vibrio pomeroyi
Vibrio splendidus
Vibrio tasmaniensis

Vibrio toranzoniae

Dieguez et al. (2011) [69]
Dieguez et al. (2011) [69]
Beaz-Hidalgo et al. (2010) [70]
Thompson et al. (2003) [71]
Faury et al. (2004) [61]
Hedlund et al. (2001) [72]
Thompson et al. (2003) [73]
Beaz-Hidalgo et al. (2009) [74]
Le Roux et al. (2005) [75]

Kim et al. (2013) [76]
Thompson et al. (2003) [71]
Maciéan et al. (2001) [77]
Ruimy et al. (1994) [78]
Thompson et al. (2003) [71]
Baumann et al. (1980) [79]
Thompson et al. (2003) [80]
Lasa et al. (2013) [81]

1.6 Identifikasjon av dyrkbare marine bakterier

Karakterisering, gruppering og identifisering av dyrkbare mikrobielle arter var opprinnelig

basert pa morfologisk karakterisering av kolonier og celler, samt biokjemiske tester som

hemolytisk aktivitet. Dette bade pa grunn av den teknologiske begrensningen far i tiden og

pavirkning av andre biologiske fagfelt, som for eksempel botanikk [82]. | dag er ogsa slike

fenotypiske undersgkelser en viktig tilngerming for karakterisering og identifisering av dyrkbare

bakterier, men som regel i kombinasjon med genetiske og/eller proteomikk analyser [83].

Serlig genetiske analyser av enkelte genetiske markarer, som for eksempel 16S rRNA-

markgren, er mye benyttet. Denne metoden er etter hvert blitt & anse som en tradisjonell metode

for identifisering av bakterier [84].
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1.6.1 Genetiske markgarer for identifisering av bakterier

16S rRNA-genet koder for en komponent pa den lille ribosomale subenhet til bakterier, og
DNA-sekvensering av dette husholdningsgenet er i dag en av de vanligste metodene for &
studere bakteriell fylogeni og taksonomi. Dette pa grunn av en rekke arsaker, som inkluderer
(I) 16S rRNA-genet er tilstedeveerende i nesten alle bakterier; (1) funksjonen til den genetiske
markgren har ikke endret seg over tid; og (I11) 16S rRNA-genet (ca. 1500 bp) er stort nok for
bioinformatiske analyser [85]. Carl Woese var en av de fgrste som analyserte og kartla 16S
rRNA-genet hos ulike bakterier ved hjelp av DNA-sekvensering i 1977, som den gang var en
toppmoderne teknologi [86]. | den senere tid har det veert en eksplosjon i antall anerkjente taksa,
og dette er direkte knyttet til hyppig bruk av 16S rRNA-sekvensering i taksonomiske studier
[85, 87-89].

Ved utfarelse av 16S rRNA-sekvensering begynner en med a ekstrahere DNAet til bakterien,
for en amplifiserer 16S rRNA-gensekvensen med benyttelse av spesifikke primere, DNA-
polymerase, nukleotider (ANTP) og et PCR-instrument (se figur 7) [65]. Deretter utfgrer en ofte
en gelelektroforese pd PCR-produktet, slik at en raskt kan sjekke at en har fatt oppkopiert
gensekvensen. Om resultatet av gelelektroforesen tilsier at en har fatt amplifisert 16S rRNA-
sekvensen til bakterien, er neste steg i prosessen rensing av PCR-produktet [90]. Videre utfgres
en ny PCR, far 16S rRNA-gensekvensen bestemmes ved hjelp av kapillaerelektroforese. Til
slutt databehandles den bestemte gensekvensen, og en far et resultat som kan benyttes til

identifisering og fylogenetiske studier av bakterien [65].
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Figur 7: Forlgpet for DNA-sekvensering av genetiske markarer, som f. eks. 16S rRNA-genet.

Selv om sekvensering av den genetiske markgren 16S rRNA er den vanligste tilneermingen for
identifikasjon og fylogenetisk studie av en bakterie, benyttes ogsa andre genetiske markarer til
samme formal. Ofte sekvenseres en eller flere andre genetiske markarer i tillegg til 16S rRNA-
genet, da sekvensering av 16S rRNA-genet hos noen bakterier kan gi begrensninger i forhold
til identifikasjon, karakterisering og gruppering [91-95]. Eksempel pa andre genetiske markarer
er ftsZ, gapA, gyrB, mreB, pyrH, rpoA, topA og recA [96]. recA har blitt foreslatt som en
potensiell genetisk markar for a oppklare fylogenetiske relasjoner mellom hgyere taksonomiske
grader, slik som familier, klasser og rekke, pa bakgrunn av sin funksjon som et husholdningsgen
og sin tilstedeveaerelse i alle bakterier [97-99]. Proteinet recA er et multifunksjonelt protein som
blant annet bidrar til homolog rekombinasjon og DNA-reparasjon [100]. Sekvensering av recA-
genet utfgres pa samme mate som 16S rRNA-sekvensering, slik som vist i figur 7, men da med

bruk av andre primere.
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1.6.2 Helgenomanalyse for identifisering av bakterier

DNA-sekvensering av genetiske markarer er et sentralt verktey innenfor mange fagfelt, og
tilnermingen benyttes av blant annet mikrobiologiske taksonomer over hele verden. Like fullt
har denne teknikken sin begrensning i forhold til & gi informasjon om alle gener i genomet til
en organisme. | dag er det mulig & utfgre helgenomanalyser, ogsa kalt helgenomsekvensering,
siden teknikkene og maskinene en benytter for & sekvensere DNA har blitt betydelig forbedret
i lgpet av de siste arene. Helgenomanalyse defineres som sekvensering av det komplette
genomet til en organisme, og den farste organismen som fikk sitt fullstendige genom sekvensert
var bakterien Haemophilus influenzae i 1995 [101, 102].

Ankomsten av helgenomanalyser har fert til at mikrobiell taksonomi na i starre grad baserer
seg pa den evolusjonare informasjonen i hele genomet til en bakterie. Sarlig benyttes
helgenomanalyser for identifisering og klassifisering av lavere taksonomiske grader som arter
og stammer, nar dette ikke lar seg gjere med den klassiske fenotypiske karakteriseringen eller
ved sekvensering av genetiske markgrer [103-105]. Imidlertid er helgenomanalyser per dags
dato fortsatt relativt kostbar og tidkrevende [106]. I tillegg er ikke alle laboratorier i besittelse
av teknologien som behgves, og ma derfor sende prevene sine til andre laboratorier for
analysering. Andre, mindre kostbare og tidkrevende metoder for identifikasjon og klassifisering
av bakteriearter og stammer er derfor a foretrekke, og i klinikken i dag benytter mange mikro-
biologiske laboratorier matrix-assisted laser desorption ionization (MALDI) time-of-flight
(TOF) mass spectrometry (MS) for identifikasjon av bakterier [107, 108].

1.6.3 MALDI-TOF MS for identifisering av bakterier

De farste som benyttet massespektrometri til bakteriell identifikasjon var Anhalt og Fenselau i
1975 [109]. Etter den tid har matrix-assisted laser desorption ionization time-of-flight mass
spectrometry (MALDI-TOF MS) blitt en viktig teknikk for deteksjon, identifikasjon og
karakterisering av mikroorganismer, og da spesielt av humanpatogene bakterier [109-112].
Metoden kan sammenliknes med sekvensering av genetiske markgrer, men har ogsa den ekstra
fordelen av & generere unike biokjemiske fingeravtrykk/spekter for subtyper av arter. Prinsippet
for metoden baserer seg pa undersgkelse av proteiner, hovedsakelig ribosomale proteiner, ved

hjelp av massespektrometri (se figur 8) [106].

Ved utfgrelse av MALDI-TOF MS blandes praven (mikroorganismen eller proteinekstrakt av

mikroorganismen) med en matrix pa en testplate, og dette bombarderes med en laser. Matrixen
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absorberer energi fra laseren, og dette fgrer til ionisering og frigjering av matrix/prove-
krystaller (se figur 8). Et elektrisk felt flytter de ioniserte proteinene gjennom en «flight tube».
Proteiner med ulik masse vil nd detektoren med ulik tid, slik at ved & male tiden det tar fra
laserpulsering til detektorsignal kan massen til proteinene beregnes. Dette visualiseres som
masse over intensitet i et spesifikt spekter/fingeravtrykk. Spekteret for prgven sammenlignes
mot referansespekter i en database, og et dataprogram angir en identitet for prgven.
Sannsynligheten for riktig identifikasjon angis med en score, som sier noe om hvor godt praven

har identitet samsvarende med spekter i databasen [106].

Laser
‘ Detector
(8]
°‘ °, 0
o s ‘D ‘ e —b"‘ —)’000 —’g o
330 * ff |
(X : :
< Matrix Time of flight tube

i
Electric
field generator

Figur 8: lllustrasjon av prinsippet for MALDI-TOF MS. Figur: Sigma Aldrich

Fordi MALDI-TOF MS er et automatisk, enkelt og hurtig identifikasjonssystem som er lite
kostbar i drift, har metoden i gkende grad erstattet DNA-baserte analyser for palitelig
identifisering av bakterier [106]. Spesielt har metoden gjort et stort inntog i diagnostiske
laboratorier, hvor de karakteriserer og identifiserer humanpatogene bakterier og andre humane
bakterier som er isolert/fremdyrket fra humant materiale [108]. Derimot er det fa rapporter om
bruk av MALDI-TOF MS for identifikasjon av marine bakterier [113, 114]. Dette blant annet
fordi de kommersielle databasene per i dag ikke er optimal for analyse av marine bakterier, da

de ikke inneholder spekter i fra alle registrerte marine bakterier [115].
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2 Bakgrunnen for denne oppgaven

Forskningsgruppen Marin Bioprospektering ved NFH har i en rekke prosjekter fokusert pa
antimikrobielle forbindelser, slik som antibakterielle peptider (AMP), hos marine invertebrater
og andre marine organismer. Blant annet er det fokusert pa at disse er forsvarsmolekyler som
er viktige i vert-mikrobe-interaksjoner. Eksempel er to hovedfamilier av AMPer fra S.

droebachiensis isolert og karakterisert ved forskningsgruppen [28].

Samtidig med denne oppgaven pagar det et doktorgradsprosjekt i forskningsgruppen pa
mikrobiotaen hos S. droebachiensis, der hensikten er & indikere patogener for arten S.
droebachiensis, samt studere interaksjonen mellom celler hos S. droebachiensis og eventuelle
patogener. Da dette doktorgradsprosjektet ble inngatt, hadde forskningsgruppen et samarbeid
med et oppdrettsfirma pa krakeboller. Firmaet hadde pa det tidspunktet en ugnsket hgy
dadelighet i anlegget. 1 tillegg hadde flere krakeboller symptomer, som for eksempel tap av
pigger og en mark overflate med et glinsende, flekkvis belegg. Noen ganger sa det ut som at de
affiserte krakebollene kom seg og de marke flekkene ble mindre, mens andre ganger degde
krakebollene. Med andre ord kunne symptomene ligne pa «skallet krakebollesyndrom» som en
kjenner fra litteraturen [10, 48, 50]. Imidlertid visste en ikke om det kunne vare hygieniske
arsaker, uheldig konstruksjons av anlegg (se figur 9), smitteagens eller en kombinasjon av flere
arsaker som forarsaket hgy dgdelighet og symptomer hos krakebollene. En visste heller ikke
om symptomene var tegn pa primere eller sekundeere effekter. Forskningsgruppen valgte
likevel & avgrense fokuset til mulig smitteagens. | farste omgang ble det dermed tatt mikro-
biologiske praver, og fokuset ble videre avgrenset til dyrkbare bakterier [Stensvag, Li, pers.

komm)].

Ved starten av det pagaende doktorgradsprosjekt, ble bade affiserte og friske S. droebachiensis
fra oppdrettsfirmaet benyttet. Det ble tatt bakterieprgver fra lesjonene/overflaten, coelom-
vaesken og peristomal membran til krakebollene, og deretter foretatt videre analyse av
koloniene som vokste opp. Serlig de bakteriene som vokste opp fra affiserte krakeboller ble
ansett som interessante. Disse bakterieisolatene ble identifisert og karakterisert ved hjelp av
morfologiske undersgkelser, 165 rRNA-sekvensering og pavisning av virulensgenet Outer

membrane protein U (OmpU) [Hira, pers. komm].
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Figur 9: Skisse for vannstrem og oppbygning av anlegg for krakebolleoppdrett. Krakebollene var
lokalisert i oppdrettsrenner, med en vanntilfarsel som starter i en del av anlegget og fortsatte til andre
deler av anlegget (bla pil). En kunne se at flere krakeboller i nedre del av anlegget tilsynelatende var
mer affisert enn krakebollene i gvre del (her illustrert med en gkende grad av markere farge).

Resultatene tilsa at de affiserte krakebollene hadde tilstedeveerelse av et hgyt antall bakterier
som tilhgrte Vibrio splendidus klade. Dette ga dermed en indikasjon pa at bakterieisolater
tilhgrende Vibrio splendidus klade, er mulige patogener for arten S. droebachiensis. Serlig to
isolater fra de syke, granne krakebollene var interessante, da disse var hemolytiske og ga utslag
for virulensgenet OmpU. Disse to bakterieisolatene ble navngitt Vibrio sp. TLO06 og Vibrio sp.
CF002. Andre bakterieisolater tilhgrende Vibrio sp. som ble isolert fra krakebollene var Vibrio
sp. TLO02, -TLO03 og -CF001 [Hira, pers. komm].

En arbeidshypotese ble dannet pa bakgrunn av disse resultatene og denne lyder som falger:

Bakteriearter innenfor Vibrio splendidus klade kan assosieres med symptomer som

karakteriseres som skallet krakebollesyndrom hos arten S. droebachiensis.
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3 Mal med oppgaven

Hovedmal

% Studere mikrobiotaen hos friske og syke krakeboller, S. droebachiensis, med et

avgrenset fokus pa dyrkbare Vibrio-bakterier

For a teste arbeidshypotesen om at arter tilhgrende V. splendidus klade kan assosieres med
symptomer karakterisert som skallet krakebollesyndrom hos arten S. droebachiensis, ble

falgende delmal definert for prosjektet:
% Utfare et lite, eksperimentelt smitteforsgk med Vibrio-bakterier isolert fra «syke»
krakeboller
% Artshestemme Vibrio-bakterier isolert fra syke krakeboller
% Utvikle en MALDI-TOF MS database for Vibrio-bakterier isolert fra syke krakeboller
< Identifisere virulensgener hos Vibrio-bakterier isolert fra syke krakeboller ved hjelp av

helgenomsekvensdata

X/
o

Sammenligne metoder for identifikasjon av arter tilhgrende V. splendidus klade
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4 Materialer og metoder

4.1 Kjemikalier og reagenser

Kjemikalier og reagenser som ble benyttet ved denne oppgaven er beskrevet i tabell 2.

Tabell 2: Oversikt over kjemikalier og reagenser benyttet ved denne oppgaven, samt produsenten til gitt

kjemikalium/reagens.

Kjemikalium/reagens:

Produsent:

Acetonitrile, >99.8%

Acetic acid, 99,5%

Agarose

Bacteriological Peptone

EDTA disodium salt dihydrate, 99-100%
Ethanol, 96%

Ethidium bromide solution, 1% in H,O
Formic Acid, >98%

Glutaraldehyde solution, 25% in H.O
Glycerol solution, 86-89%

Marine Broth

NaCl

NaH.PO4x 12 H,0
NaH.PO4

Osmium tetroxide
Poly-L-lysine solution
Trizma base

Ultra-Pure Water

4.2 Dyrkingsmedier og buffere

Sigma-Aldrich Inc., Steinheim, Tyskland
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.

Difco™, Becton Dickinson and Company,
Sparks, USA

Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Sigma-Aldrich Inc.
Biochrom GmbH, Berlin, Tyskland

Bakterielle dyrkingsmedier som ble benyttet for oppdyrking av marine bakterier ved denne opp-
gaven var Fortynnet-Marin-Agar-Pepton (FMAP) agar, -broth og -blod agar [Landfald, pers.
komm]. Oppskriften for tillaging av disse mediene, i tillegg til bufferne som ble benyttet i denne

oppgaven, er beskrevet i tabell 3.
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Tabell 3: Oversikt over innholdet i de ulike mediene og bufferne som ble benyttet i denne oppgaven.
Produsent av kjemikaliene som ble benyttet er oppgitt i tabell 2.

Navn pa medium/buffer: Innhold i medium/buffer:

FMAP agar 0,15% Marine Broth,
0,05% Bacteriological Peptone,
0,15% Agarose,
3% sterilt sjgvann.

FMAP broth 0,15% Marine Broth,
0,05% Bacteriological Peptone,
3% sterilt sjgvann.

FMAP blod agar 0,15% Marine Broth,
0,05% Bacteriological Peptone,
0,15% Agarose,
5% Sheep Blod,
3% sterilt sjgvann.

Fosfatbuffer med salt (PBS) 0,22% NaH2PO4 * 12 H20,
0,06% NaH.PO,,
0,90% NaCl.
Tris-Acetate-EDTA (TAE) buffer 0,48% Trizma base,

0,11% Acetic acid
0,20% EDTA

4.3 Primere benyttet for sekvensering av genetiske markgarer

Primerne som ved denne oppgaven ble benyttet for sekvensering av genetiske markarer er alle
produsert av Sigma-Aldrich Inc. En oversikt over primerne, samt deres gitte primersekvens er
vist i tabell 4.

Tabell 4: Oversikt over primere som ble benyttet for sekvensering av genetiske markgrer ved denne
oppgaven, samt deres gitte primersekvens.

Navn pa primer: Primersekvens:

16S rRNA-B27-Forward «AGAGTTTGATCCTGGCTCAG»
16S rRNA-U1492-Revers «GGTTACCTTGTTACGACTT»
recA-01-Forward «TGARAARCARTTYGGTAAAGG»
recA-02-Revers «TCRCCNTTRTAGCTRTACC»
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4.4 Biologisk materiale
4.4.1 Krakeboller

Ved denne oppgaven ble det isolert og identifisert dyrkbare marine bakterier fra 12 stk. friske
Strongylocentrotus droebachiensis, som var oppsamlet utenfor Tromsg i slutten av februar
2016 og lagret i tank ved NFH. De 12 krakebollene hadde ikke synlig dannelse av lesjon pa

kroppsoverflaten, var 4-5 cm. i diameter og veide ca. 40-50g.

| tillegg ble det ved denne oppgaven benyttet 72 stk. S. droebachiensis til et eksperimentelt
smitteforsgk. Disse krakebollene ble oppsamlet i begynnelsen av mai 2016 av Jonathan Hira
(UIT), Hege Devold (UiT) og dykker Phillip James (Nofima), like utenfor Havbruksstasjonen
i Tromsg AS lokalisert i Karvika. Krakebollene hadde ikke synlig lesjondannelse pa overflaten,

var 4-5 cm. i diameter og veide ca. 40-50g.
4.4.2 Bakterier

Bakterieisolatene Vibrio sp. TL002, -TL003, -TL006, -CF001 og -CF002, isolert ved den
overnevnte doktorgradstudien, ble benyttet ved denne oppgaven. Bakterienavn med bokstavene
TL betyr at bakterieisolatet var isolert fra lesjon, mens bakterienavn med bokstavene CF betyr

at isolatet var isolert fra coelomveesken.

Vibrio anguillarum LFI 317 [116], isolert fra atlantisk laks av Norsk Veterinarinstitutt (NV1),
ble benyttet som kontroll ved analysering pa MALDI-TOF MS.

4.5 Eksperimentelt, innledende smitteforsgk
4.5.1 Oppstalling av krakeboller for smitteforsgk

Et eksperimentelt, innledende smitteforsgk ble utfart ved fiskehelselaboratoriet hos Havbruks-
stasjonen i Tromsg AS. Det ble benyttet 72 stk. friske, granne krakeboller, og disse ble fordelt
i 6 tanker (A, B, C, D, E og F) med 12 stk. krakeboller i hver tank. Tankene inneholdt et
avlgpssystem som kontinuerlig drenerte ut sjgvann i fra bunnen av tankene, samt et innlgps-
system som kontinuerlig tilfgrte friskt, rent sjgvann inn i tankene. Figur 10 viser et fotografi av
tankene som ble benyttet. Hver tank rommet 30 liter, men inneholdt under hele smitteforsgket
bare 20 liter sjgvann. Vannet hadde en temperatur pa omtrent 12 °C, en oksygenmetning pa ca.

100% og en salinitet lik sjgvannet pa yttersiden av havbruksstasjonen. Fgr vannet ble drenert
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ut fra anlegget pa havbruksstasjonen tilbake til sjgen, ble det kokt opp til 90 °C. Dette ble utfart
for & drepe alt av smitteagens.

Innlgpssystem

Avlgpssystem

Figur 10: Fotografi av tankene ved fiskehelselaboratoriet i Karvika som ble benyttet i det
eksperimentelle smitteforsgket, hvor friske S. droebachiensis ble introdusert for Vibrio sp. CF002 og -
TLOO6. Foto: Solveig Bentdal

4.5.2 Oppdyrking av bakterier for smitteforsgk

Bakteriene som ble benyttet ved smitteforsgket var isolatene Vibrio sp. CF002 og -TL0O06,
isolert ved det pagaende doktorgradsprosjektet. Oppdyrkingen av disse to bakteriene ble utfart
i FMAP broth pa shaker (1000 rpm) ved 12 °C i ca. 24 timer. Etter tilneermet 24 timer ble absor-
bansen (OD600) malt med spektrofotometeret BioMate 3 (Thermo Scientific, Waltham, USA),
med den hensikt & beregne konsentrasjonen av bakterieceller i 1 ml FMAP broth (1 abs. = ca.

10° cfu/ml). Beregnet bakteriekonsentrasjon ble benyttet for tillaging av FMAP broth med 10°
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— 107 cfu/ml, samt for utregning av hvilken mengde FMAP broth med bakterie som skulle
tilsettes tankene med 20 liter sjgvann.

4.5.3 Besmitte krdkeboller med bakterie

For miljgtilpasning og stressreduksjon av krakebollene ble krakebollene oppbevart i sine
tildelte tanker i ca. 48 timer. Videre ble det dannet overflatesar pa krakebollene i tank B, D og
E. Dette vil si at i et omrade pa 1 — 1,5 cm pa krakebollens overflate ble piggene klippet av, i

tillegg til at omradet ble oppskrapet med en skalpell.

24 timer etter sardannelsen ble krakebollene i tank A og B eksponert for bakterien Vibrio sp.
TL006, mens krakebollene i tank C og D ble eksponert for bakterien Vibrio sp. CF002 (se figur
11). Eksponeringen av bakterie ble utfert ved at krakebollene med tilfart sar fikk spraytet 500
uL FMAP broth med bakterie (ca. 10° — 107 cfu/ml) over séromrédet, far de videre ble plassert
i tildelt tank med innhold av omtrent 10° — 107 cfu/ml sjgvann. Krakebollene uten sar fikk ikke
sproytet bakterier over seg, men ble direkte plassert i tildelt tank med innhold av omtrent 10° —
107 cfu/ml sjgvann. Avlgpet og tilfarselen av rent vann ble i alle tankene stengt av i 2 timer, far
alt vann ble drenert ut og nytt vann ble tilfart. Krakebollene i tank A, B, C og D la dermed og
badet i bakterier i 2 timer. Krakebollene i kontrollgruppene (tank E og F) ble ikke besmittet
med bakterie, og ble derfor bare eksponert for de bakteriene som allerede var tilstede i/pa

dyrene eller i vannet i lgpet av de to timene.

Kontrollgrupper Eksponert for Eksponert for
Vibrio sp. TLOO6 Vibrio sp. CFO02
Uten sar
Tank F Tank A Tank C
Tilfgrt sar
Tank E Tank B Tank D

Figur 11: Tankoppsettet/forsgksdesignet for det eksperimentelle smitteforsgket utfert ved havbruks-
stasjonen. De granne krakebollene ble fordelt i 6 tanker/grupper, der krakebollene i tank F verken ble
tilfart sar eller eksponert for bakterie, tank E fikk tilfert sar, tank A ble eksponert for Vibrio sp. TLOO0G,
tank B ble tilfart sar og eksponert for Vibrio sp. TLO06, tank C ble eksponert for Vibrio sp. CF002, og
tank D ble tilfgrt sar og eksponert for Vibrio sp. CF002.
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4.5.4 Forlgpet av smitteforsgk etter besmittelse med bakterie

Etter at krakebollene ble eksponert for bakterie pagikk det eksperimentelle smitteforsgket
videre i fire uker fgr det ble avsluttet. I lgpet av disse fire ukene oppholdt krakebollene seg i
sine tildelte tanker, med et lysregime som besto av 12 timer lys per 12 timer mgrke. Hver uke
ble krakebollene studert visuelt, men personalet ved havbruksstasjonen hadde kontinuerlig
overblikk over krakebollene. To uker inn i forsgket ble krakebollene foret med pellet fatt av
Nofima. Ved forsgkets endelse ble krakebollene fraktet pa is til laboratoriet ved NFH, hvor de
ble studert, fotografert og tatt mikrobiologiske prever av (se «4.6 Prgvetakning» for beskrivelse

av prgvetakningen).

4.6 Prgvetakning av Krakeboller

Det ble tatt praver av overflaten, coelomvasken og peristomal membran til 12 stk. friske S.
droebachiensis. | tillegg ble det tatt praver av overflaten og coelomvasken til krakebollene som
hadde veert med i det eksperimentelle smitteforsgket. Metodene for prgvetakningen er neermere

beskrevet nedenfor.
Forut for prgvetakningen ble hver krakebolle skylt i sterilt sjgvann.
4.6.1 Prgvetakning av coelomvaske (CF)

Provetakning av coelomveeske (CF) ble utfert ved at en sprgyte med kanyle (stagrrelse
1,2x40mm) ble stukket igjennom peristomal membran og inn i coelomic hulrom. Omtrent 1,5
ml CF ble deretter tappet ut fra coelomic hulrom og fordelt etter falgende: (I) 1 ml CF ble for-
delt i to r@r og oppbevart med 40% glyserol i en 1:1 lgsning i -80 °C, mens (I1) 100 pL CF ble
benyttet til utseed av bakterier pa FMAP agar. Agarskalen med tilfgrt CF ble satt til inkubering
i 12 °C for dyrkning av bakterier.

4.6.2 Prgvetakning av overflaten/test part (TP)

Prgvetakning av overflaten til krakebollene ble utfgrt noe ulikt i forhold til om krakebollene
hadde lesjondannelse eller ikke. Om krakebollene hadde lesjondannelse ble skadeomradet med
lesjon tatt prave av, mens om krakebollene ikke hadde lesjondannelse ble det tatt prover av et
tilfeldig omrade pa krakebollens overflate. Overflateprgvene (TP) ble tatt ved at omradet
med/uten lesjon ble skrapet med en skalpell, slik at en fikk noe utskrap av det vevet som befant

seg pa prevetakningsomradet. Utskrapet ble overfart til to eppendorfrar med innhold av 1 ml
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sterilt sjgvann, og begge eppendorfrgrene ble deretter mikset godt. 1 ml veske fra det ene
eppendorfraret ble fordelt i to rer og oppbevart med 40% glyserol i en 1:1 lgsning i -80 °C,
mens 100 pL veske fra det andre eppendorfrgret ble benyttet til utseed av bakterier pa FMAP
agar. Agarskalen med tilfgrt TP-suspensjon ble satt til inkubering i 12 °C for dyrkning av

bakterier.
4.6.3 Prgvetakning av peristomal membran (PM)

Prgvetakning av peristomal membran (PM) ble bare utfart pa de 12 friske, granne krakebollene
oppsamlet like utenfor Tromsg, og ikke pa krakebollene fra det eksperimentelle smitteforsgket.
Pravetakningen foregikk ved at PM ble klippet/skjert ut fra krakebollene og most i 2 ml sterilt
sjgvann. 1 ml PM-suspensjon ble deretter fordelt i to rer og oppbevart med 40% glyserol i en
1:1 lgsning i -80 °C, mens 100 puL PM-suspensjon ble benyttet til utseed av bakterier pa FMAP
agar. Agarskalen med tilfgrt PM-suspensjon ble, i likhet med agarskalene med tilfgrt CF eller
TP, satt til inkubering i 12 °C for dyrkning av bakterier.

4.7 Isolering av dyrkbare bakterier fra ramateriale

Omtrent en uke etter prgvetakning ble agarskalene med tilfert ramateriale fra S. droebachiensis
studert, far enkeltkolonier med lignende morfologi som Vibrio sp. ble selektert og isolert (se
«4.8.1 Morfologisk undersgkelse av kolonier» for beskrivelse av hvordan den morfologiske
undersgkelsen ble utfgrt). Med andre ord ble enkeltkolonier med lik morfologi som Vibrio sp.
plukket ut, sadd ut pa ny FMAP agar og inkubert ved 12 °C i ca. 5-7 dager, slik at bakterie-
isolatene ble rendyrket. Bakterieisolatene fikk utdelt navn etter hvilke krakeboller de var isolert
fra, samt hvilket prgvemateriale de var isolert fra. De ble videre fryst ned med 20% glyserol i
FMAP broth ved -80 °C, for lagring og oppbevaring til senere analyser.

4.8 Morfologisk undersgkelse av bakterieisolater

Ved denne oppgaven ble det utfert morfologiske undersgkelser av kolonier og celler pa
bakterieisolatene. Dette vil si at morfologien til alle dyrkbare bakteriekolonier ved denne

oppgaven ble undersgkt, men bare morfologien til isolerte bakterieisolater ble beskrevet.
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4.8.1 Morfologisk undersgkelse av kolonier

Morfologisk undersgkelse av bakteriekolonier ble utfart ved dyrke frem kolonier pa FMAP
agar ved 12 °C i 72 timer. Videre ble kolonienes kulturelle sertrekk pa agarskalene visuelt
studert og beskrevet. | tabell 5 vises en oversikt over hvilke szrtrekk som ble studert og hvordan
de eventuelt ble beskrevet. For a studere om bakteriene viste hemolytisk aktivitet, ble en enkelt-
koloni dyrket i 3 ml FMAP broth pa shaker (1000 rpm) ved 12 °C i 24 timer. Etter 24 timer ble
1 drape FMAP broth med bakterie overfart til FMAP blod agar, hvor kolonier ble dyrket frem
ved 12 °C i 72 timer. Bakterienes hemolytiske aktivitet ble bestemt ved & studere om det var
oppklaring rund koloniene (3-hemolyse), om agaren var mgrk og grgnnlig under koloniene (a-
hemolyse) eller om agaren var uforandret rundt og under koloniene (ikke hemolyse).

Tabell 5: Oversikt over bakteriekolonienes kulturelle sartrekk som ble studert, samt hvordan de ble
beskrevet.

Seertrekk: Beskrivelse:

Starrelse Liten (< 1 mm)
Middels (1-2 mm)
Stor (> 2 mm)

Farge Farge pa koloniene, samt om de er
gjennomskinnelige eller ugjennomskinnelige
Form Rund @)
Ujevn begrensning O
Konsistens Mukoid (slimete)
Tarr
Fet
Beliggenhet i forhold til hverandre For seg selv med klare grenser

Flytende over hverandre med uklare grenser

Hemolyse (FMAP blod agar) Ikke hemolytisk
a-hemolytisk
B-hemolytisk

4.8.2 Skanning-Elektron-Mikroskopering (SEM)

Morfologisk undersgkelse av bakterieceller ble utfart ved hjelp av SEM. For utfgrelse av SEM
ble bakterieisolatene dyrket i 1 ml FMAP broth pa shaker (1000 rpm) ved 12 °C i 24 timer.
Deretter ble 100 pul oppdyrket bakterie fiksert i 3% glutardialdehyd i PBS, pH 7,3, ved 4 °C i
ca. 19 timer. Etter ca. 19 timer ble prgvene med bakterieisolatene transportert til Elektron-

mikroskopavdelingen ved UiT, hvor de ble sentrifugert (spunnet ned) og tilsatt 2,5%
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glutardialdehyd i PBS-buffer. Videre ble draper av pregvene pasatt pa Poly-L-Lysine-coata
dekkglass, hvor de ble (I) vasket med PBS-buffer, (1) tilsatt 1% vandig Osmiumtetroxid for 30
min, (111) dehydrert med stigende konsentrasjon av etanol, (IV) tarket med kritisk punkt terking,
(V) tarket i eksikator med silicagel, (V1) montert pa aluminiumstubber, (VII) padampet gull,
og tilslutt (VI111) mikroskopert og fotografert med SEM-instrumentet Zeiss Merlin VP Compact
(Carl Zeiss Microscopy GmbH, Munich, Tyskland).

For morfologisk undersgkelse av bakteriecellene ble mikroskoperingsbildene visuelt studert,

og sartrekk som celleform, overflatekarakteristikk og forekomst av flagell ble beskrevet.

4.9 Sekvensering av 16S rRNA-genet til bakterieisolater

Sekvensering av 16S rRNA-genet ble utfert pa isolerte bakterier. For 16S rRNA-sekvensering
ble en enkeltkoloni dyrket i 3 ml FMAP broth pa shaker (1000 rpm) ved 12 °C i 24 timer
benyttet. Etter 24 timer ble 1 ml FMAP broth med bakterie overfort til et eppendorfrar og sentri-
fugert i 10 min ved 8000 rpm, for klargjering til ekstraksjon av DNA.

4.9.1 DNA-ekstraksjon fra bakteriekultur

DNA-ekstraksjonen av bakteriekulturene ble utfert med bruk av DNeasy Blod & Tissue kit fra
QIAGEN (Hilden, Tyskland). Anbefalt protokoll tilhgrende Kittet ble fulgt for utfgrelse av DNA-
ekstraksjonen. Kort fortalt ble bakteriecellene lysert ved hjelp av proteinase K, far lysatet ble
pipettert til en spinn-kolonne. Ved sentrifugering ble DNA selektivt bundet til DNeasy-
membranen i kolonnen, mens resterende cellekomponenter ble fjernet med to vasketrinn,

DNAEet ble tilslutt eluert fra membranen med vann.
4.9.2 Amplifisering av 16S rRNA-genet

| forkant av amplifiseringen av 16S rRNA-genet ble DNA-konsentrasjonen i ekstraktene
kvantitert ved hjelp av NanoDrop® ND-1000 Spektrofotometer (NanoDrop Products,
Wilmington, USA). DNA-konsentrasjonen til templat ved amplifisering skal ideelt vaere mellom
20— 50 ng/ul. Dermed ble ekstraktene fortynnet i vann om malt DNA-konsentrasjon var hgyere
enn 50 ng/pl.

Amplifiseringen ble utfgrt ved hjelp av 16S rRNA Polymerase Chain Reaction (PCR), der det
til hver prave ble tilsatt 2,5 pl Standard Taq Buffer (New England Biolabs Inc, Ipswich, USA), 0,3
pl Taqg DNA polymerase (New England Biolabs Inc), 0,5 pl GeneAmp dNTPs (Thermo Scientific),
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0,5 pl 16S rRNA Forward Primer (Sigma-Aldrich Inc), 0,5 pl 16S rRNA Revers Primer (Sigma-
Aldrich Inc), 21,0 pl ultra pure water, samt 1-2 pl templat (mengde valgt ut i fra DNA-
konsentrasjonen i ekstrakt). Totalt volum i hver prgve var dermed 26 pl. Instrumentet
GeneAmp PCR System 2700 (Applied Biosystems, California, USA) ble benyttet, med en
programinnstilling hvor pravene ble kjgrt i 5 min. ved 95 °C, etterfulgt av 30 sykluser med 95
°C for 30 sek, 55 °C for 30 sek og 72 °C for 1,5 min. Etter 30 sykluser ble prgvene kjart i 10
min ved 72 °C, fer de ble lagret ved 4 °C inntil videre analyse pa gelelektroforese og

sekvensering.
4.9.3 Gelelektroforese pa PCR-produkt

Etter utfgrelse av 16S rRNA PCR ble det utfgrt en gelelektroforese pa PCR-produktet, for a
kontrollere at en hadde fatt oppkopiert 16S rRNA-genet. Gelen som ble laget til
gelelektroforesen besto av TEA-buffer, 1% Agarose og 0,01% etidiumbromid. Over gelen ble
det tilsatt destillert vann, mens i kamrene ved siden av gelen ble det tilsatt TEA-buffer.
Ladderen GeneRuler 1 kb DNA Ladder (Thermo Scientific) ble benyttet, og prgvene ble blandet
med 6X DNA Loading Dye (Thermo Scientific) far de ble tilsatt til brannene pa gelen. Elektro-
foresen ble utfart ved bruk av instrumentet Power PAC 300 fra BIO-RAD, med en spenning pa
200V i 11 min. For synliggjering og billedtaking av gelen og band for 16S rRNA-genet ble
instrumentet GeneGenius Bio Imaging System (Syngene, Cambridge, England) benyttet.

4.9.4 Rensing av PCR-produkt

Kittet QIAquick PCR Purification kit (QIAGEN) ble benyttet for rensing av PCR-produkt.
Anbefalt protokoll tilhgrende kittet ble fulgt for utfgrelse av DNA-rensingen. Kort fortalt ble
det tilsatt bindingsbuffer direkte til PCR-produktet, far blandingen ble pipettert til en spinn-
kolonne. Ved sentrifugering ble nukleinsyrer selektivt bundet til silikamembranen i kolonnen,
mens urenheter ble fjernet med ett vasketrinn. Renset DNA ble tilslutt eluert fra membranen

med en liten mengde vann.
4.9.5 Sekvensering av nukleotidsekvensen

Forut for bestemmelsen av nukleotidsekvensen til 16S rRNA-genet ble det utfgrt en ny PCR,
hvor hver pragve ble tilsatt 15 pl ultra pure water, 2 pl sequencing buffer (Applied Biosystems),
1 pl Big Dye (Applied Biosystems), 1 pl 16S rRNA Revers Primer (Sigma- Aldrich Inc) og 4-5 pl
templat (mengde valgt ut i fra DNA-konsentrasjonen i renset PCR-produkt). Instrumentet
GeneAmp PCR System 2700 (Applied Biosystems) ble benyttet for PCR-analysen, med en
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programinnstilling hvor pravene ble kjgrt i 5 min. ved 95 °C, etterfulgt av 40 sykluser med 95
°C for 10 sek, 55 °C for 10 sek og 60 °C for 4 min. Deretter ble prgvene lagret ved 4 °C, for

selve sekvenseringen ble utfart.

Sekvenseringen av nukleotidsekvensen til 16S rRNA-genet ble utfart av Medisinsk Genetisk
avdeling pa Universitetssykehuset Nord Norge (UNN) ved hjelp av kapillerelektroforese-
instrumentet 3130x| Genetic Analyzer (Applied Biosystems).

4.9.6 Sekvensbehandling

Programmet CLC Sequence Viewer 7.7 (QIAGEN) og programmet Sequence Scanner Software
(Applied Biosystems) ble benyttet for databehandling av nukleotidsekvensene til de ulike
bakterieisolatene. Sekvensbehandlingen ble utfert ved at to duplikater av 16S rRNA-
gensekvensen til et bestemt isolat ble overlappet med hverandre. Overlappingen av to sekvens-
duplikater ble utfgrt for a forsikre at en fikk en resulterende gensekvens med riktig nukleotid-
sammensetning for det bestemte isolatet. Den resulterende 16S rRNA-gensekvensen til isolatet
ble videre sgkt opp mot tilgjengelig data i databasen ved National Center for Biotechnology

Information (NCBI, http://blast.ncbi.nim.nih.gov/Blast.cgi), hvor nukleotidlikheten mellom

sekvensen til bestemt isolat og sekvensene til bakteriene i databasen ble oppgitt i prosent. Den
bakterien i databasen som viste best sekvenslikhet med sekvensert isolat, ble angitt som
identitet for den bestemte isolaten.

4.10 Sekvensering av RecA-genet til bakterieisolater

RecA-sekvenseringen ble utfart pa tilneermet samme mate som for sekvensering av 16S rRNA-
genet (se «4.9 16S rRNA-sekvensering»), da protokollen for DNA-ekstraksjonen, gel-
elektroforesen, rensingen av PCR-produkt, selve sekvenseringen av nukleotidsekvensen og
databehandlingen av sekvensen hos begge metodene var identisk. Derimot ble det benyttet
andre primere og annen mengde med primer ved amplifiseringen og sekvenserings-PCRen av
recA-genet, i tillegg til at amplifiseringen av recA-genet ble ufgrt med en ulik program-

innstilling. De endrede betingelsene er gjengitt nedenfor.

Amplifiseringen av recA-genet ble utfgrt ved at hver prgve ble tilsatt 2,5 pl Standard Taq Buffer
(New England Biolabs Inc,), 0,3 pl Taqg DNA polymerase (New England Biolabs Inc), 0,5 il dNTPs
(Thermo Scientific), 0,5 pl recA Forward Primer (Sigma-Aldrich Inc), 0,5 ul recA Revers Primer

(Sigma-Aldrich Inc), 16,7 pl ultra pure water, samt 1-2 ul templat (mengde valgt ut i fra DNA-
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konsentrasjonen i ekstrakt). Totalt volum i hver prgve var dermed 21 pl. Det ble benyttet en
programinnstilling hvor prgvene ble kjart i 5 min ved 95 °C, etterfulgt av 3 sykluser med 95 °C
for 45 sek, 55 °C for 2 min og 72 °C for 1 min, som igjen ble etterfulgt av 30 sykluser med 95
°C for 20 sek, 55 °C for 1 min og 72 °C for 1 min. Etter de siste 30 syklusene ble prgvene kjort
i 7 min ved 72 °C, fer de ble lagret ved 4 °C inntil videre analyse pa gelelektroforese og

sekvensering.

Sekvenserings-PCRen ble utfagrt ved at hver prgve ble tilsatt 10 pl ultra pure water, 2 pl
sequencing buffer (Applied Biosystems), 1 pl Big Dye (Applied Biosystems), 2,5 il recA Revers
Primer (Sigma-Aldrich Inc) og 4-5 pl templat (mengde valgt ut i fra DNA-konsentrasjonen i
renset PCR-produkt). Programinnstillingen som ble benyttet for recA-sekvenserings-PCRen

var lik som programinnstillingen til 16S rRNA-sekvenserings-PCRen.

4.11 Helgenomanalyse av bakterieisolater

Helgenomanalyse pa Vibrio sp. TLO06 og -CF002, ble utfart som en del av det pagaende
doktorgradsprosjektet. Med andre ord utfgrte Jonathan Hira DNA-ekstraksjon pa bakteriene,
for han sende DNA-ekstraktene til firmaet MicrobesNG (Birmingham, England) for selve
analysen. Analyseresultatet av bakteriefamilie, -slekt og art, samt resulterende nukleotid-
sekvens fatt av MicrobesNG ble benyttet ved denne oppgaven.

Resulterende nukleotidsekvenser ble opplastet i dataprogrammet RAST (http://rast.nmpdr.org).

Dette for videre prosessering, slik at en med det tilhgrende programmet the Seed Viewer

(http://www.theseed.org) kunne sub-kategorisere gensekvensene etter hva genene kodet for.

For sgk og identifikasjon av enkelte virulensgener ble proteinsekvensen til et spesifikt bestemt

gen sgkt pa og innhentet hos UniProt (http://www.uniprot.org/), fgr innhentet sekvens ble

BLAST-sgkt med resulterende nukleotidsekvenser.

4.12 MALDI-TOF MS-analyse av bakterieisolater

For analysering pa MALDI-TOF MS ble en enkeltkoloni dyrket i 3 ml FMAP broth pa shaker
(1000 rpm) ved 12 °C i 24 timer benyttet. Etter 24 timer ble 1 ml FMAP broth med bakterie
overfart til et eppendorfrgr og sentrifugert i 2 min ved 10 000 g, fer supernatant ble pipettert

ut. Pelleten ble deretter ekstrahert for protein.
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4.12.1 Proteinekstraksjon

Proteinekstraksjonen ble utfart tilnaermet slik som beskrevet av Freiwald og Sauer [117]. 1 ml
ultra pure water ble tilsatt til pelleten/praven, far praven ble sentrifugert i 2 min ved 10 000 g.
Videre ble supernatant pipettert ut, og det ble tilsatt 300 pl ultra pure water og 900 pul 96%
etanol. Prgven ble nok en gang sentrifugert i 2 min ved 10 000 g, fgr supernatant ble pipettert
ut og sentrifugeringen ble gjentatt. En mindre pipette ble deretter benyttet til a fjerne resten av
supernatanten, slik at bare pelleten 13 igjen i eppendorfraret. Eppendorfraret ble holdt apen for
2 — 3 min, slik at pelleten ble helt tarr. Etter tarking ble proven tilsatt 40 pl 70% maursyre, som
ble blandet med pelleten i ca. 2 min. Til slutt ble 40 pl acetonitril tilsatt til preven, for preven
ble sentrifugert i 2 min ved 10 000 g og lagret ved 4 °C inntil analysering pa MALDI-TOF MS.

Bakterien V. anguillarum LFI 317 [116] ble benyttet som kontroll for proteinekstraksjonen,

samt for selve analysen.
4.12.2 Analysering

Analysering av preve pa MALDI-TOF MS ble utfert ved avdeling for mikrobiologi og
smittevern pa Universitetssykehuset Nord-Norge (UNN). Far gjennomfgring av selve analysen
ble 1 pl proteinekstrakt pafert en stalplate kalt MSP 96 target polished steel BC (Bruker Daltonics
GmbH, Bremen, Tyskland). Drapen med proteinekstrakt ble deretter lufttarket, far 1 pl Bruker
Matrix HCCA (Bruker Daltonics) ble pafart over proteinekstraktet. Etter luftterking av matrixen
ble stalplaten plassert inn i instrumentet Microflex LT (Bruker Daltonics), som genererte
biokjemiske spekter ved hjelp av dataprogrammet FlexControl Software (Bruker Daltonics). For
bade kalibrering og kontroll av analysen ble det benyttet en ekstern Bacterial Test Standard
(Bruker Daltonics), som bestar av ekstrakt fra Escherichia coli DH5 alpha og som dekker en
masse ratio pa 3600 — 17 000 Da. Parameterne som ble benyttet for analysen er beskrevet i
tabell 6.
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Tabell 6: Parameterne som ble benyttet for analysering av prave pa MALDI-TOF MS-instrumentet
Microflex LT.

Parameter: Value:

Mass to charge ratio (m/z) range: 2000 — 20 000 Da

Laser: 60,0 Hz

lon source 1: 19,98 kV

lon source 2: 18,08 kV

Lens: 5,99 kV

Mode: Positive linear mode

Laser shots: 240 laser shots in 40 shot steps from different
positions of the target spot

Extraction delay time: 120 ns

Laser attenuation offset: 21%

4.12.3 Databehandling

Et biokjemisk spekter produsert ved analysering av preve pa MALDI-TOF MS ble, ved hjelp
av dataprogrammet MALDI Biotyper 3.1 (Bruker Daltonics), sammenlignet med referanse-
spekter i enten utviklet database eller databasen fra Bruker. MALDI Biotyper kalkulerte en
logaritmisk «score value», basert pa hvor godt referansespekter i databasen samsvarte med
prevens spekter. Kalkuleringen av score value ble utfgrt med en «matching-algoritme», og er
detaljert beskrevet i appendiks 1. Benyttet betydning av kalkulert score value er vist i tabell 7.
De ti referansespektrene som fikk hgyest score value ble rangert i en liste, hvor
referansespektret med hgyest score value ble plassert gverst i listen. Bakterien tilhgrende dette

referansespektret ble derfor oppgitt som mest sannsynlig identitet til praven.

Tabell 7. Betydningen av Score Value, kalkulert av dataprogrammet MALDI Biotyper 3.1 (Bruker
Daltonics). Isolatene som er identifisert med en score value over 2,3 er antatt & vare identifisert som
korrekt slekt og art, isolatene som er identifisert med en score value mellom 2,0 og 2,3 er antatt 3 vere
identifisert med korrekt slekt og trolig korrekt art, isolatene som er identifisert med en score value
mellom 1,7 og 2,0 er antatt & vaere identifisert med trolig korrekt slekt og mulig korrekt art, mens
isolatene som er identifisert med en score value under 1,7 regnes som ikke mulig a identifisere.

Range Description Color

2,300 - 3,000 Highly probable species identification Green
2,000 - 2,299 Secure genus identification, probable species identification Green
1,700 - 1,999 Probable genus identification Yellow
0,000 - 1,699 Not reliable identification Red
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4.12.4 Utvikling av MALDI-TOF MS database

MALDI-TOF MS database ble utviklet ved at fem enkeltkolonier (fem biologiske replikaer) fra
hver bakterie ble dyrket i hver sin FMAP broth ved 12 °C i 24 timer. Videre ble de fem
biologiske replikaene fra hver bakterie ekstrahert slik som beskrevet i «4.12.1 Protein-
ekstraksjonx», og analysert slik som beskrevet i «4.12.2 Analysering». Analyseringen ble utfart
fem ganger (fem tekniske replikaer) pa hver biologisk replika, slik at det ble 25 spekter totalt
for hvert bakterieisolat (5 biologiske replikaer x 5 tekniske replikaer). Kvaliteten til hvert
spekter ble wvurdert med dataprogrammet mMass 5.5.0 (Martin Strohalm, 2013,

http://www.mmass.org), etter utfarelse av «smoothing» (Savitzky Golay algoritme) og «baseline

correction» (TopHat algoritme) pa raspektrene. Spekter med utilstrekkelig kvalitet ble fjernet
fra samlingen, og ytterligere malinger ble gjennomfart for & oppna 25 spekter for hver bakterie.
Raspektrene ble deretter lastet inn i MALDI Biotyper 3.1 (Bruker Daltonics), og utav disse ble
det opprettet main spectra (MSPs)/referansespekter for innsetting til egenutviklet database. Se
appendiks 1 for detaljert beskrivelse av dataprosessen for utvikling av MSPs og database.
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5 Resultater

Upubliserte funn fra pagaende doktorgradsprosjekt hos forskningsgruppen Marin Bio-
prospektering ved NFH indikerte at bakterieisolater tilhgrende V. splendidus klade, isolert fra
syke S. droebachiensis fra et oppdrettsanlegg, kunne vere patogen for arten S. droebachiensis.
Serlig to Vibrio-isolater, navngitt Vibrio sp. TL006 og Vibrio sp. CF002, var spesielt
interessante i forhold til sykdom hos de grenne krakebollene. Observasjonen dannet grunnlaget
for denne hypotesen: Bakteriearter innenfor V. splendidus klade kan assosieres med symptomer

som karakteriseres som skallet krakebollesyndrom hos arten S. droebachiensis.

5.1 Identifisering av bakterieisolater fra friske S. droebachiensis

For & teste den overnevnte hypotesen var det viktig & utelukke tilstedevaerelse av bakterier
tilhgrende V. splendidus klade hos friske S. droebachiensis. Pravemateriale fra 12 stk. friske S.
droebachiensis ble derfor tilfart agarskaler, og dyrkbare bakterier tilstedeveerende hos
krakebollene ble dyrket opp. Ett par bakteriekolonier med lignende morfologi som Vibrio sp.
(hvitaktig, runde, sma/middels store) fra hver agarskal ble videre selektert og isolert (se eks. i
figur 12). Dette resulterte i totalt 21 kolonier som ble valgt ut for videre analyse (se isolatnavn
i figur 13). Identifiseringen av de 21 bakterieisolatene ble utfert ved hjelp av 16S rRNA-

sekvensering.

Selektert, isolert
og identifisert

Figur 12: Eksempel pa agarskal med tilfert ramateriale fra friske S. droebachiensis. En ser vekst av ulike
bakterier, med ulik starrelse, konsistens og farge. Likevel ble bare de med lignende morfologi som
Vibrio sp. selektert og isolert, for videre identifisering med hjelp av 16S rRNA-sekvensering (bla pil).
Foto: Solveig Bentdal
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Resultatene etter identifiseringen viste tilstedeveaerelse av to Vibrio sp. blant de 21 isolerte
bakteriene fra krakebollene (se figur 13). Imidlertid tilharte, ifalge NCBI-databasen, bare én av
isolatene V. splendidus klade (V. tasmaniensis). Resultatene viste i tillegg tilstedeverelse av
Photobacterium, Acinetobacter, Shewanella, Roseobacter, Agarivorans, Pseudomonas,
Allivibrio, Moritella, Thalassomonas og Colwellia hos de 12 krakebollene (se bakterie-

distribusjonen i figur 13).

Photobacterium sp. (SUH-CF011)
Acinetobacter sp. (SUH-CF012)
Shewanella sp. (SUH-CF015)

* Roseobacter sp. (SUH-CF023)

* Agarivorans sp. (SUH-PM023)

* Pseudomonas sp. (SUH-TP011, -PM011)

* Allivibrio sp. (SUH-PM015, -PM016)

* Moritella sp. (SUH-CF013, -CF0 14, PM017)

* Thalassomonas sp. (SUH-CF025, -TP021, -

PM014)

* Colwellia sp. (SUH-CF022, -TP013, -TP014, -
PM013)

* Vibrio sp. (tapetis) (SUH-PM021)

* Vibrio sp. (tasmaniensis) (SUH-CF021)

Figur 13: Resultat av 16S rRNA-sekvensering pa 21 dyrkbare bakterier, selektert og isolert fra friske S.
droebachiensis. Navn pa isolater er angitt i parentes bak slektsnavnene listet opp til venstre. Isolater
identifisert som Vibrio sp. er uthevet med radlig farge, og NCBI-databasens «best match» av art er angitt
i parentes bak slektsnavnet.
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5.2 Eksperimentelt, innledende smitteforsgk pa S. droebachiensis
5.2.1 Karakterisering av S. droebachiensis etter utfgrt smitteforsgk

Den overnevnte hypotesen ble ogsa testet ved a utfgre et eksperimentelt, innledende
smitteforsgk, hvor friske S. droebachiensis med/uten tilfert sar ble eksponert for enten
bakterieisolatet Vibrio sp. TLOO6 eller Vibrio sp. CF002. Hensikten med forsgket var blant
annet a studere om Vibrio sp. TL0O06 og/eller Vibrio sp. CF002 kunne fremkalle sykdoms-
symptomer hos arten S. droebachiensis. Forsgket var et innledende forsek som skulle gi

indikasjon pa administrasjon og bestemmelse av parametere ved et reelt, nytt smitteforsgk.

Etter endt smitteforsgk viste krakebollene i kontrollgruppene E (med sar) og F (uten sar) ingen
tegn til lesjondannelse, tap av pigger eller tap av sugefetter. Derimot hadde krakebollene en
visuelt frisk overflate uten lesjoner og med mange, grenne pigger (se figur 14). 1 tillegg viste
krakebollene i tank E tegn til utvekst av nye pigger i omradet hvor krakebollene var blitt tilfort

o

Sar.

Figur 14: Fotografi av en grenn krakebolle fra tank F (venstre) og en grenn krakebolle fra tank E (hayre).
Krakebollene har en visuelt frisk overflate uten lesjoner og med mange, grenne pigger. Krakebollen fra
tank E har god utvekst av nye pigger i omradet hvor krakebollen var blitt tilfert sar (se bla pil). Foto:
Solveig Bentdal

Krakebollene i tank A (uten sar) og B (med sar), som var blitt eksponert for Vibrio sp. TL0OS,
viste en overflate med noe markere farge sammenlignet med krakebollene fra kontrollgruppene.
Likevel var det utseendemessige individuelle forskjeller av overflaten til krakebollene i tank A

og B. Dette vil si at noen krakeboller lignet mer pa krakebollene fra kontrollgruppene, mens
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andre hadde en mgrkere overflate med ferre pigger (se figur 15 og 16). En krakebolle i tank A
viste synlig tegn til lesjondannelse, samt tap av pigger og sugefatter i omradet med lesjon (se
fotografiet til hgyre i figur 15). Denne krakebollen skilte seg derfor signifikant ut i forhold til
de resterende krakebollene i tank A og B, da de ikke viste tydelig tegn til karakteristisk lesjon-
dannelse pa sin kroppsoverflate. Hos flere av krakebollene i tank B kunne en se utvekst av nye
pigger i omradet hvor krakebollene var blitt tilfert sar (se fotografiet til venstre i figur 16).

Figur 15: Fotografi av to granne krakeboller fratank A, hvor en krakebolle er uten synlig lesjon (venstre)
og en er med synlig lesjon (hgyre, bla pil). Begge krakebollene har en mark overflate med relativt fa
pigger. Foto: Solveig Bentdal og Jonathan Hira

Figur 16: Fotografi av to grenne krakeboller fra tank B. Krakebollen til venstre viser tydelig tegn til
utvekst av nye pigger i omradet hvor krakebollen var blitt tilfert sar (bla pil). Begge krakebollene har
en mark overflate med relativt fa pigger. Foto: Solveig Bentdal
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Krakebollene i tank C (uten sar) og D (med sar), som var blitt eksponert for Vibro sp. CF002,
viste etter avsluttet smitteforsgk lignende tendens som krakebollene fra tank A og B (se figur
17 og 18). Flere av krakebollene hadde en overflate med noe markere farge sammenlignet med
krakebollene fra kontrollgruppene, mens andre igjen lignet krakebollene fra kontrollgruppene.
Med andre ord var det utseendemessige individuelle forskjeller av overflaten til krakebollene
ogsa i tank C og D. Derimot var det til forskjell fra tank A og B ingen antydning til dannelse
av lesjon hos noen av krakebollene i tank C eller D. I tillegg bar det nevnes at hos samtlige
krakeboller i tank D kunne en se god utvekst av nye pigger i omradet hvor krakebollene var
blitt tilfart sar. Imidlertid ble en krakebolle i tank D tatt prgver av 2 uker etter oppstart av
smitteforsgket, da krakebollen hadde mistet stort sett alle piggene sine, ble spist pa av de andre

krakebollene i samme tank, samt var i ferd med & dg.

Figur 17: Fotografi av to granne krakeboller fra tank C. Begge krakebollene har en overflate uten synlig
dannelse av lesjon, men med en relativt mark farge. Foto: Solveig Bentdal

Figur 18: Fotografi av to granne krakeboller fra tank D. Begge krakebollene har en overflate uten synlig
dannelse av lesjon, i tillegg til en god utvekst av nye pigger i omradet hvor krakebollene var blitt tilfart
sar (se bla pil i fotografiet til hgyre). Foto: Solveig Bentdal
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5.2.2 Isolering og identifisering av isolater fra S. droebachiensis

Etter utfort eksperimentelt smitteforsgk ble det tatt mikrobiologiske prgver av hver av
forsgksdyrene, med den hensikt & re-isolere bakterieisolatene Vibrio sp. TL006 og Vibrio sp.
CF002 som deltakende S. droebachiensis var blitt eksponert for i starten av smitteforsgket.
Isoleringen ble utfert for & gi en indikasjon pa om de krakeboller som var blitt smittet med

bakterie fortsatt hadde tilstedeveerelse av gitt isolat.

Isoleringen ble utfert ved a selektere og isolere en bakterie, med lignende morfologi som Vibrio
sp., fra hver agarskal med tilfert ramateriale (se navn pa isolatene i tabell 8). Ved enkelte
agarskaler vokste det opp flere ulike kolonier, mens ved andre agarskaler var det ingen vekst
av noen kolonier (se figur 19). Pa agarskalen med tilfart lesjon, fra den krakebollen med lesjon-
dannelse i tank A, dominerte én type bakterie (se figur 20). Dette begrunnes med at det visuelt

sa ut som vekst av bare en type bakterie pa agarskalen, og ingen vekst av andre typer dyrkbare

bakterier.

Figur 19: Fotografi av 3 stk. agarskaler med tilfgrt ramateriale fra S. droebachiensis som deltok i
smitteforsgket. Agarskalene er delt i to, der ramateriale fra en krakebolle er tilfgrt den ene delen og
ramateriale fra en annen krakebolle er tilfgrt den andre delen. 1 og 1l viser vekst av flere ulike bakterier,
mens 111 viser ingen vekst av bakterie. Foto: Solveig Bentdal
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Figur 20: Oppvekst av bakterier pa agarskalen med tilfert rdmateriale fra krakebollen med
lesjondannelse i tank A. Ser umiddelbart ut som om én bakterie er dominerende pa agarskalen.
Foto: Jonathan Hira og Solveig Bentdal

Identifiseringen av bakterieisolatene ble utfert ved hjelp av 16S rRNA-sekvensering.
Resultatene etter identifiseringen viste tilstedevaerelse av tre Vibrio sp. blant de dyrkbare
bakteriene fra krakebollene i tank A, ingen tilstedeverelse av Vibrio sp. blant de dyrkbare
bakteriene fra krakebollene i tank B, C og D, en Vibrio sp. blant de dyrkbare bakteriene fra
krakebollene i tank E, samt tre Vibrio sp. blant de dyrkbare bakteriene fra krakebollene i tank
F (se tabell 8). Alle isolatene identifisert som Vibrio sp. var isolert fra ulike krakebolleindivider,
og samtlige av disse isolatenes 16S rRNA-sekvenser viste god match med sekvenser hos flere
ulike arter fra V. splendidus klade i NCBI-databasen. Bakterieisolaten isolert fra lesjonene til
den krakebollen med lesjondannelse i tank A ble navngitt SUA-TP-A1 og identifisert som V.

splendidus.
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Tabell 8: Resultat etter utfart 16S rRNA-sekvensering pa bakterieisolater fra S. droebachiensis som
deltok i eksperimentelt smitteforsgk. Isolater identifisert som Vibrio sp. er uthevet med rgd farge, og
NCBI-databasens «best match» av art er angitt i parentes bak slektsnavnet.

Sample Type of bacterium
Gr. A

SUA-TP-A1 Vibrio sp. (splendidus)
SUA-TP-A2 Sulfitobacter sp.
SUA-TP-A3 Sulfitobacter sp.
SUA-TP-A4 Sulfitobacter sp.
SUA-TP-A5 Primorskyibacter sp.
SUA-TP-AG6 Roseobacter sp.
SUA-TP-A7 Marinobacter sp.
SUA-TP-A8 Bacillus sp.
SUA-TP-A12 Sulfitobacter sp.
SUA-CF-Al Tenacibaculum sp.
SUA-CF-A2 Colwellia sp.
SUA-CF-A3 Vibrio sp. (splendidus)
SUA-CF-A4 Vibrio sp. (splendidus)
SUA-CF-A8 Thalassomonas sp.
Gr, B

SUA-TP-B1 Roseobacter sp.
SUA-TP-B2 Proteobacter sp.
SUA-TP-B5 Roseobacter sp.

Gr.C

SUA-TP-C1 Lutibacter sp.
SUA-TP-C4 Rhodobacterales sp.
SUA-TP-C5 Marinobacter sp.
Gr.D

SUA-2W-TP-D1 Psychromonas sp.
SUA-2W-TP-D2 Celeribacter sp.
SUA-2W-TP-D3 Thalassospira sp.
SUA-2W-CF-D1 Pseudoalteromonas sp.
SUA-2W-CF-D2 Pseudoalteromonas sp.
SUA-TP-D4 Roseobacter sp.
SUA-TP-D5 Rhodobacterales sp.
Gr. E

SUA-TP-E1 Sulfitobacter sp.
SUA-TP-E6 Vibrio sp. (hemicentroti)
SUA-CF-E8 Psychromonas sp.
SUA-CF-E9 Psychromonas sp.
Gr. F

SUA-TP-F1 Alteromonas sp.
SUA-TP-F4 Roseobacter sp.
SUA-TP-F11 Vibrio sp. (splendidus)
SUA-CF-F5 Vibrio sp. (gallaecicus)
SUA-CF-F9 Vibrio sp. (lentus)
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5.3 Karakterisering og identifisering av bakterieisolater

Pa grunn av vanskeligheter med a arts- og stamme-bestemme bakterieisolater tilhgrende Vibrio
splendidus klade, ble det utfgrt videre karakterisering og identifisering av isolatene Vibrio sp.
TLOO2, -TLOO03, -TL006, -CF001, -CF002 og SUA-TP-A1 med bruk av ulike metoder.

5.3.1 Morfologisk undersgkelse av kolonier og celler

Det ble utfert morfologiske undersgkelser pa bakterieisolatene Vibrio sp. TL002, -TL0O03, -
TL006, -CF001, CF002 og SUA-TP-A1, for & studere og sammenligne isolatenes kulturelle
sertrekk mot hverandre. Morfologisk undersgkelse og hemolytisk aktivitet av kolonier ble
utfert ved & studere bakteriekoloniene visuelt pA FMAP agar og FMAP blod agar, mens
morfologisk undersgkelse av celler ble utfgrt ved hjelp av SEM. Nedenfor er bakterieisolatene
listet opp, og under navnet til hver av isolatene er det bilder og tabell med beskrivelse av

morfologien til kolonier og celler.

Vibrio sp. TL002:

Tabell 9: Beskrivelse av morfologien til koloniene (se figur 21) og cellene (se figur 22) til Vibrio sp.
TL002.

Seertrekk for Beskrivelse av Seertrekk for Beskrivelse av celler:

kolonier: kolonier: celler:

Starrelse: Sma Farge: Hvitaktig

Farge: Gulaktig, Form: Buet stangform /
gjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende

Konsistens: Mukoid Flagell: En

Beliggenhet i forhold

til hverandre:

Hemolyse:

Tett. Uklare grenser
som flyter inn i

hverandre

Ikke hemolytisk
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Figur 21: Fotografi av koloniene til Vibrio sp. TL0O02 pa FMAP agar og FMAP blod agar. Koloniene er
gulaktige, gjennomskinnelige, mukoid, sma, har rund form, uklare grenser og er ikke hemolytisk. Foto:
Solveig Bentdal

1pm Mag= 18.15KX EHT = 2.00 kv Signal A = InLens Date :2 Feb 2017
|—| WD = 2.8 mm File Name = TL002 Time :12:44:39

Figur 22: SEM-bilde av cellen til Vibrio sp. TL0O02. Cellen har en buet stangform med en ujevn,
fluktuerende overflate og en eneste flagell. Foto: Tom-Ivar Eilertsen
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Vibrio sp. TL003:

Tabell 10: Beskrivelse av morfologien til koloniene (se figur 23) og cellene (se figur 24) til Vibrio sp.
TLOO3.

Seertrekk for Beskrivelse av Seertrekk for Beskrivelse av celler:

kolonier: kolonier: celler:

Starrelse: Middels stor Farge: Hvitaktig

Farge: Huvitaktig, Form: Buet stangform /
ugjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende

Konsistens: Fet Flagell: En

Beliggenhet i forhold Sprett med relativt - -

til hverandre: klare grenser

Hemolyse: B-hemolytisk - -

Figur 23: Fotografi av koloniene til Vibrio sp. TL003 pa FMAP agar og FMAP blod agar. Koloniene er
hvite, ugjennomskinnelige, fet, middels stor, har rund form, klare grenser og er B-hemolytisk.
Foto: Solveig Bentdal
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1pm Mag= 1212KX EHT = 1.50 kv Signal A = InLens Date :3 Feb 2017

|—| WD= 24mm File Name = TL003 Time :10:29:07
Figur 24: SEM-bilde av cellen til Vibrio sp. TL003. Cellen har en buet stangform med en ujevn,
fluktuerende overflate og en eneste flagell. Foto: Tom-Ivar Eilertsen

Vibrio sp. TLOQOG6:

Tabell 11: Beskrivelse av morfologien til koloniene (se figur 25) og cellene (se figur 26) til Vibrio sp.
TLOOG.

Seertrekk for Beskrivelse av Seertrekk for Beskrivelse av celler:

kolonier: kolonier: celler:

Starrelse: Middels stor Farge: Hvitaktig

Farge: Hvitaktig, Form: Buet stangform /
ugjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende

Konsistens: Fet Flagell: En

Beliggenhet i forhold Sprett med relativt - -

til hverandre: klare grenser

Hemolyse: B-hemolytisk - -
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Figur 25: Fotografi av koloniene til Vibrio sp. TLO06 pa FMAP agar og FMAP blod agar. Koloniene er
hvite, ugjennomskinnelige, fet, middels stor, har rund form, relativt klare grenser og er p-hemolytisk.
Foto: Solveig Bentdal

200 nm Mag= 2479KX EHT = 1.50 kV Signal A = InLens Date :3 Feb 2017
'_| WD = 27 mm File Name = TLOOG Time :10:47:06

Figur 26: SEM-bilde av cellen til Vibrio sp. TLO06. Cellen har en buet stangform med en litt fluktuerende
overflate og en eneste flagell. Foto: Tom-lvar Eilertsen
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Vibrio sp. CF001:

Tabell 12: Beskrivelse av morfologien til koloniene (se figur 27) og cellene (se figur 28) til Vibrio sp.

CF001.
Sertrekk for Beskrivelse av Sertrekk for Beskrivelse av celler:
kolonier: kolonier: celler:
Starrelse: Sma Farge: Hvitaktig
Farge: Huvitaktig, Form: Buet stangform /

ugjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende
Konsistens: Mukoid Flagell: En
Beliggenhet i forhold Sprett med relativt - -
til hverandre: klare grenser
Hemolyse: Ikke hemolytisk - -

Figur 27: Fotografi av koloniene til Vibrio sp. CF001 pa FMAP agar og FMAP blod agar. Koloniene er
hvite, ugjennomskinnelige, mukoid, sma, har rund form, relativt klare grenser og er ikke hemolytisk.

Foto: Solveig Bentdal
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1pm Mag= 16.38 K X EHT = 1.50 kV Signal A = InLens

WD = 2.7 mm File Name = CFOOl

Date :3 Feb 2017
Time :10:04:36

Figur 28: SEM-bilde av cellen til Vibrio sp. CF0O01. Cellen har en buet stangform med en ujevn,

fluktuerende overflate og en eneste flagell. Foto: Tom-Ivar Eilertsen

Vibrio sp. CF002:

Tabell 13: Beskrivelse av morfologien til koloniene (se figur 29) og cellene (se figur 30) til Vibrio sp.

CF002.
Seertrekk for Beskrivelse av Seertrekk for Beskrivelse av celler:
kolonier: kolonier: celler:
Starrelse: Middels stor Farge: Hvitaktig
Farge: Gul-hvitaktig, Form: Buet stangform /

gjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende
Konsistens: Mukoid Flagell: En
Beliggenhet i forhold Sprett med relativt - -
til hverandre: klare grenser
Hemolyse: B-hemolytisk - -
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Figur 29: Fotografi av koloniene til Vibrio sp. CF002 pa FMAP agar og FMAP blod agar. Koloniene er
hvite/gulaktig, ugjennomskinnelige, mukoid, middels stor, har rund form, Kklare grenser og er [-
hemolytisk. Foto: Solveig Bentdal

1 um EHT= 2.00kV Mag= 16.90 KX Signal A = InlensDuo Date :27 Feb 2017
D= 43mm FileName= CFQ02 Noise Reduction = Frame Avg Time :12:36:21

ZEISS

Figur 30: SEM-bilde av cellen til Vibrio sp. CF002. Cellen har en buet stangform med en ujevn,
fluktuerende overflate og en eneste flagell. Foto: Tom-Ivar Eilertsen
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SUA-TP-AL:

Tabell 14: Beskrivelse av morfologien til koloniene (se figur 31) og cellene (se figur 32) til SUA-TP-
Al.

Sertrekk for Beskrivelse av Sertrekk for Beskrivelse av celler:

kolonier: kolonier: celler:

Starrelse: Middels stor Farge: Hvitaktig

Farge: Huvitaktig, Form: Buet stangform /
ugjennomskinnelig kommaform

Form: Rund Overflate: Fluktuerende

Konsistens: Fet Flagell: En

Beliggenhet i forhold Sprett med relativt - -

til hverandre: klare grenser

Hemolyse: B-hemolytisk - -

Figur 31: Fotografi av koloniene til SUA-TP-A1 pa FMAP agar og FMAP blod agar. Koloniene er hvite,
ugjennomskinnelige, fet, middels stor, har rund form, klare grenser og er f-hemolytisk. Foto: Solveig
Bentdal

49



1 pm Mag= 1521KX EHT = 1.50 kv Signal A = InLens Date :3 Feb 2017
i—‘ WD = 2.8mm File Name = TP-A1 Time :9:40:08

Figur 32: SEM-bilde av cellen til SUA-TP-AL. Cellen har en buet stangform med en ujevn, fluktuerende
overflate og en eneste flagell. Foto: Tom-Ivar Eilertsen

Resultatene etter den morfologiske undersgkelsen av bakterieisolatenes kolonier og celler, viste
at isolatene var sveert like. De har alle kolonier med rund form, og celler med en buet stangform,
fluktuerende overflate og en eneste flagell. Likevel ligner koloniene til Vibrio sp. TLOO3, -
TL006, og SUA-TP-AL mer pa hverandre, enn pa koloniene til Vibrio sp. TL002, -CF001, og -
CF002. Nar det er sagt ligner ikke Vibrio sp. TL002, -CF001, og -CF002 pa hverandre, da
TLOO2 er mer gjennomskinnelig enn CF001, og CF002 er stgrre og -hemolytisk i forhold til

de to andre.

5.3.2 ldentifisering ved hjelp av 16S rRNA- og recA-sekvensering

Det ble utfart en ny 16S rRNA-sekvensering, samt en recA-sekvensering pa bakterieisolatene
Vibrio sp. TL002, -TL003, -TL006, -CF001, CF002 og SUA-TP-Al, med den hensikt &
artsbestemme isolatene. De resulterende 16S rRNA- og recA-sekvensene til isolatene ble
undersgkt opp mot databasen til NCBI, og samtlige sekvenser viste god match med sekvenser
hos flere ulike arter i databasen. | tabell 15 vises isolatenes «best mach» av art basert pa
sammenligning av 16S rRNA-sekvensen til gitt isolat mot 16S rRNA-sekvensen til ulike arter

i NCBI-databasen, og i tabell 16 vises isolatenes «best mach» av art basert pa sammenligning
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av recA-sekvensen til gitt isolat mot recA-sekvensen til ulike arter i NCBI-databasen.
Nukleotidlikheten mellom sekvensen til gitt isolat og sekvensen til «best matchx» er oppgitt i

parentes bak artsnavnet.

Tabell 15: Sammenligning av isolater med hensyn pa 16S rRNA. Bakterieisolatene Vibrio sp. TL002, -
TLO03, -TLO06, -CF001, CF002 og SUA-TP-AL sitt resultat for «best mach» av art, basert pa
sammenligning av 16S rRNA-sekvensen til gitt isolat mot 16S rRNA-sekvensen til ulike arter i NCBI-
databasen. Nukleotidlikheten mellom sekvensen til gitt isolat og sekvensen til «best match» er oppgitt i
parentes bak artsnavnet.

Sample Best match of species
(16S rRNA Ident)

Vibrio sp. TLO02 Vibrio gallaecicus (97%)

Vibrio sp. TLOO3 Vibrio lentus (98%)

Vibrio sp. TL0O06 Vibrio splendidus (98%)

Vibrio sp. CF001 Vibrio cortegadensis (97%)

Vibrio sp. CF002 Vibrio splendidus (97%)

SUA-TP-Al Vibrio tasmaniensis (93%)

Tabell 16: Sammenligning av isolater med hensyn pa recA. Bakterieisolatene Vibrio sp. TL002, -TL0O03,
-TLOO06, -CF001, CF002 og SUA-TP-AL sitt resultat for «best mach» av art, basert pa sammenligning
av recA-sekvensen til gitt isolat mot recA-sekvensen til ulike arter i NCBI-databasen. Nukleotidlikheten
mellom sekvensen til gitt isolat og sekvensen til «best match» er oppgitt i parentes bak artsnavnet.

Sample Best match of species
(recA ldent)
Vibrio sp. TL002 Vibrio splendidus (88%)
Vibrio sp. TL0OO3 Vibrio splendidus (96%)
Vibrio sp. TLO06 Vibrio tasmaniensis (99%)
Vibrio sp. CF001 Vibrio cortegadensis (98%)
Vibrio sp. CF002 Vibrio hemicentroti (97%)
SUA-TP-A1 Vibrio splendidus (96%)

Resultatene etter sekvenseringen av 16S rRNA-genet og recA-genet vister at de to
sekvenseringsmetodene gir ulikt resultat av art hos nesten alle bakteriene. Bare Vibrio sp.
CFO001 identifiseres som V. cortegadensis ved begge metodene. Denne bakterien tilhgrer ikke

V. splendidus klade, slik som de andre artene listet opp i tabell 15 og 16.
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5.3.3 Identifisering ved hjelp av MALDI-TOF MS

Det ble utfart MALDI-TOF MS pa bakterieisolatene Vibrio sp. TL002, -TL003, -TLO006, -
CF001, CF002 og SUA-TP-A1, med den hensikt & artsbestemme isolatene. | tillegg ble det
utviklet en MALDI-TOF MS database for de overnevnte isolatene, utenom SUA-TP-AL, for &
studere hvilken stamme SUA-TP-A1 tilhgrer og for a lettere kunne identifisere om ukjente

bakterier er av samme art og stamme som en av de overnevnte isolatene.
5.3.3.1 Identifisering med Bruker Daltonics MALDI-TOF MS database

Resultatene etter utfert MALDI-TOF MS pa bakterieisolatene, med benyttelse av Bruker
Daltonics database for identifikasjon, er vist i tabell 17. De to kontrollene (Vibrio anguillarum
LFI 317 og BTS — E.coli) som ble benyttet, ble identifisert som korrekt bakterieslekt og
bakterieart. Vibrio sp. TLO03 og -CF002 ble identifisert som sikker slekt Vibrio og trolig art
tasmaniensis, Vibrio sp. TLO06 og SUA-TP-AL ble identifisert som trolig slekt Vibrio og mulig
art tasmaniensis, mens Vibrio sp. TL0O02 og -CF002 ikke kunne identifiseres.

Tabell 17: Resultater fra MALDI-TOF MS. Identifikasjon av bakterieisolatene Vibrio sp. TL002, -
TLOO3, -TL006, -CF001, CF002 og SUA-TP-A1, etter utfart MALDI-TOF MS med benyttelse av Bruker
Daltonics database. Oppgitt score value er basert pa hvor godt referansespekter i databasen samsvarte
med prevens spekter, og benyttet betydning av kalkulert score value er vist i tabell 7.

Analyte Name Analyte ID Organism (best match) Score Value

A5 Vibrio anguillarum LFI 317  Vibrio anguillarum 2,392
A6 Vibrio CF002 Vibrio tasmaniensis 2,158
A7 Vibrio CFO01 not reliable identification 1,298
A8 Vibrio TLO02 not reliable identification 1,452
A9 Vibrio TLOO3 Vibrio tasmaniensis 2,016
A10 Vibrio TLOO6 Vibrio tasmaniensis 1,906
All Vibrio TP-A1 Vibrio tasmaniensis 1,818
Al12 Vibrio TP-Al Vibrio tasmaniensis 1,794
B1 BTS - E.coli Escherichia coli 2,285

5.3.3.2 Utvikling av MALDI-TOF MS database

Det ble utviklet en MALDI-TOF MS database for bakterieisolatene Vibrio sp. TL002, -TL003,

-TLOO06, -CF001 og -CF002. For hver bakterie ble det utviklet totalt 25 referansespekter (5
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biologiske replikaer x 5 tekniske replikaer) til databasen, og en av disse referansespektrene for

alle isolatene er vist i figurene nedenfor.
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Figur 33: En av totalt 25 referansespekter som ble utviklet for Vibrio sp. TL002.
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Figur 34: En av totalt 25 referansespekter som ble utviklet for Vibrio sp. TLOOS.
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Figur 35: En av totalt 25 referansespekter som ble utviklet for Vibrio sp. TLO06.
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Figur 36: En av totalt 25 referansespekter som ble utviklet for Vibrio sp. CFO01.
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Figur 37: En av totalt 25 referansespekter som ble utviklet for Vibrio sp. CF002.

5.3.3.3 ldentifisering med egenprodusert MALDI-TOF MS database

For & validere databasen og for & studere hvilken stamme SUA-TP-A1 tilhgrer, ble bakterie-
isolatene Vibrio sp. TL002, -TLO03, -TL006, -CF001, CF002 og SUA-TP-A1 identifisert med
benyttelse av MALDI-TOF MS og egenprodusert database. Resultatene etter utfert MALDI-
TOF MS pa bakterieisolatene er vist i tabell 18. Kontrollen (Vibrio anguillarum LF1 317) som
ble benyttet ble identifisert som korrekt bakterieslekt og bakterieart, og bakterieisolatene Vibrio
sp. TL0O2, -TLOO3, -TLO06, -CF001 og -CFO002 ble identifisert som korrekt stamme. To
paralleller av bakterieisolaten SUA-TP-AL ble begge identifisert som bakteriestammen Vibrio
sp. TLOO3. De resulterende spektrene til isolatene SUA-TP-AL og Vibrio sp. TLOO3 ble derfor
sammenlignet opp mot hverandre. En kunne se at de hadde sveert like spekter, men med noen
ulike topper (se figur 38). 1 tillegg ble spektrene til SUA-TP-A1 og Vibrio sp. TLO06
sammenlignet opp mot hverandre, pa grunn av at en etter utfert smitteforsgk mistenkte at SUA-
TP-A1 var en re-isolat av Vibrio sp. TLO06. Figur 39 viser at ogsa disse to isolatene hadde sveert

like spekter. Likevel var det noen ulike topper mellom spektrene til disse to isolatene.
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Tabell 18: Resultat av MALDI-TOF MS pa marine bakterier. Identifikasjon av bakterieisolatene Vibrio sp.
TL0O02, -TLOO03, -TLO06, -CF001, CF002 og SUA-TP-AL, etter utfart MALDI-TOF MS med benyttelse
av egenprodusert database. Oppgitt score value er basert pa hvor godt utviklet referansespekter i
databasen samsvarte med prgvens spekter, og benyttet betydning av kalkulert score value er vist i tabell
7.

Analyte Name Analyte ID Organism (best match) Score Value

A5 Vibrio anguillarum LFI 317  Vibrio anguillarum 2,483
A6 Vibrio CF002 Vibrio CF002 1c 2,638
A7 Vibrio CF001 Vibrio CFO01 5a 2,493
A8 Vibrio TLO02 Vibrio TLOO2 3a 2,623
A9 Vibrio TLOO3 Vibrio TLOO3 2b 2,887
A10 Vibrio TLOO6 Vibrio TLOO6 1d 2,643
All Vibrio TP-Al Vibrio TLOO3 2d 2,481
A12 Vibrio TP-A1 Vibrio TLOO3 2¢ 2,462
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Figur 38: Sammenligning av MALDI-TOF MS spektrene for SUA-TP-A1 og Vibrio sp. TLO03.
Spekteret til SUA-TP-AL er flippet opp ned. Kan se at spektrene er veldig like, men det er likevel noen
topper som er ulike mellom spektrene (se blae piler for eksempler pa ulike topper).

56



Vibrio tasmaniensis TA1 ¢
TLO06 1B *

30000

-30000

T T T T
3000 6000 9000 12000

m/z

Figur 39: Sammenligning av MALDI-TOF MS spektrene for SUA-TP-Al og Vibrio sp. TLOO6.
Spekteret til SUA-TP-AL er flippet opp ned. Kan se at spektrene er veldig like, men det er likevel noen
topper som er ulike mellom spektrene (se rade piler for eksempler pa ulike topper).

5.3.4 Karakterisering og identifisering ved hjelp av helgenomanalyse

For & artshestemme stammene Vibrio sp. TLO06 og -CF002, samt identifisere enkelte virulens-
gener hos stammene, ble helgenomsekvensene til TLO06 og CF002 benyttet. Resultatet
overlevert av MicrobesNG etter utfgrt helgenomanalyse viser at begge isolatene ble identifisert
som arten V. tasmaniensis (se tabell 19). Resultater etter prosessering og sub-kategorisering av
gener i programmet RAST og the Seed Viewer er vist i figur 40 for TLO06 og figur 41 for
CF002. Ved BLAST-sgk etter enkelte virulensgener ble OmpU-genet, vsm-genet, flagell-gener

0g hemolyse-gener funnet hos begge isolatene (se tabell 20).
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Tabell 19: Identifikasjonsresultat fatt av MicrobesNG etter utfart helgenomanalyse. Bade Vibrio sp.
TLOO06 og -CF002 ble identifisert som arten V. tasmaniensis.

Closest neighbors

Size

GC Content

N50
L50

Number of Contigs (with PEGs)

Number of subsystems
Number of Coding Sequences

Number of RNAs
Subsystem Category Distribution

Sample | Unclassified Most Most Most Most Most Most
(%) frequent | frequent | frequent @ frequent frequent frequent
Family Family genus genus species species
(%) (%) (%)
TLOO06 34,01 65,06 Vibrionaceae | 64,62 Vibrio 62,59 V.
tasmaniensis
CF002 35,39 63,68 | Vibrionaceae ~ 63,16 Vibrio 60,77 V.
tasmaniensis
Genome Vibrio sp. TL006
Domain Marine Bacteria
Taxonomy Bacteria; Proteobacteria; Gammaproteobacteria;

Vibrionales: Vibrionaceae; Vibrio: Vibrio
tasmaniensis.

Vibrio cyclitrophicus

5543 148

44,1%

344240

5

169

536
4822

183

Subsystem Feature Counts
am Cofactors vltamms Prosthetlc Groups, Pigments (330)

photosynthesis (0)
Miscellaneous (43)
Phages, Prophages, Transposable elements, Plasmids (8)
Membrane Transport (230)

Iron acquisition and metabolism (79)

RNA Metabolism (237)

Nucleosides and Nucleotides (117)

Protein Metabolism (317)

Cell Division and Cell Cycle (41)

Motility and Chemotaxis (108)

Regulation and Cell signaling (111)

Secondary Metabolism (4)

DNA Metabolism (112)

Fatty Acids, Lipids, and Isoprenoids (149)

Nitrogen Metabolism (59)

Dormancy and Sporulation (4)

Respiration (149)

Stress Response (150)

Metabolism of Aromatic Compounds (22)

Amino Acids and Derivatives (500)

Sulfur Metabolism (49)

G Phosphorus Metabolism (62)

Carbohydrates (430)

Figur 40: Helgenomsekvensdata etter prosessering av nukleotidsekvensen til TLO06. Genene er
kategorisert i subsystem, og gener som koder for virulens, sykdom og forsvar er uthevet i radt.
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Genome
Domain
Taxonomy

Closest neighbors
Size

GC Content

NS5O

L50

Number of Contigs (with PEGs)

Number of subsystems

Number of Coding Sequences

Number of RNAs

Subsystem Category Distribution

Vibrio sp. CF002

Marine Bacteria

Bacteria: Proteobacteria: Gammaproteobacteria:
Vibrionales: Vibrionaceae: Vibrio: Vibrio
tasmaniensis.

Vibrio cyclitrophicus

5655029

44.1%

317388

6

162

539

4993

188
Subsystem Feature Counts
@M Cofactors, Vitamins, Prosthetic Groups, Pigments (331)
R\

(5] W v

4@ Virulence, Disease and Defense (113)

m D

@M Photosynthesis (0)
@ Miscellaneous (44)
@M Phages, Prophages, Transposable elements, Plasmids (7)
@ m Membrane Transport (280)

@M Iron acquisition and metabolism (72)

@ RNA Metabolism (235)

@M Nucdleosides and Nucieotides (114)

@m Protein Metabolism (323)

@M Cell Division and Cell Cyde (44)

@ Motility and Chemotaxis (112)

@M Regulation and Cell signaling (123)

®  Secondary Metabolism (4)

@®m DNA Metabolism (116)

@@ Fatty Acids, Lipids, and Isoprencids (147)

@@ Nitrogen Metabolism (59)

@MW Dormancy and Sporulation (4)

@M Respiration (155)

@M Stress Response (158)

® Metabolism of Aromatic Compounds (22)

® Amino Acids and Derivatives (498)

@  Sulfur Metabolism (48)
@
@

Phosphorus Metabolism (60)
Carbohydrates (434)

Figur 41: Helgenomsekvensdata etter prosessering av nukleotidsekvensen til CF002. Genene er
kategorisert i subsystem, og gener som koder for virulens, sykdom og forsvar er uthevet i rgdt.

Tabell 20: Funn av virulensgenene OmpU og vsm, samt flagell- og hemolyse-gener. Begge isolatene
har tilstedevaerelse av disse genene (X er angitt for funn av gen).

Virulensgen: OmpuU vsm Flagell Hemolyse
Isolat:

TLOO6 X X X X

CF002 X X X X
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6 Diskusjon

o

Den grenne krakebollen, S. droebachiensis, synes a veere utsatt for sykdom bade i
akvakulturnringen og i naturen [10]. Likevel er ingen patogener for krakeboller kjent i
litteraturen, men rapporterte symptomer har gitt navn til flere ulike krakebollesykdommer.
Blant annet har symptomer som tap av pigger og sugefatter, samt utvikling av marke, glinsende
lesjoner, gitt navn til krakebollesykdommen «skallet krakebollesyndrom», pa engelsk kalt
«bald sea urchin disease/spotting disease» [2, 48, 53]. En arbeidshypotese i forbindelse med et
pagaende doktorgradsprosjekt i forskningsgruppen Marin Bioprospektering ved NFH, er at
bakteriearter innenfor V. splendidus klade kan assosieres med skallet krakebollesyndrom hos
S. droebachiensis [Hira, Stensvag, Li, pers. komm]. Fokuset i denne oppgaven har dermed vaert
pa marine Vibrio-bakterier fra bade friske og syke S. droebachiensis. Det er blant annet forsgkt
a pafere infeksjon hos friske krakeboller ved et lite smitteforsgk. Med valgt oppsett for smitte-
forsgk, og med unntak av et individ, lyktes det ikke a verifisere hypotesen om at arter tilhgrende
V. splendidus klade kan assosieres med symptomer karakterisert som skallet krakebolle-
syndrom hos S. droebachiensis. | denne oppgaven har det i tillegg veert viktig & ha fokus pa
identifisering av de marine bakteriene isolert fra S. droebachiensis. Det ble dermed utviklet en
MALDI-TOF MS database for hurtig pavisning og karakterisering av enkelte Vibrio-bakterier.
Dette ble sammenstilt med helgenomanlysedata.

6.1 Mikrobiotaen hos S. droebachiensis

Ved isolering og identifisering av Vibrio-lignende bakterier fra friske S. droebachiensis, ble det
funnet Vibrio, Photobacterium, Acinetobacter, Shewanella, Roseobacter, Agarivorans,
Pseudomonas, Allivibrio, Moritella, Thalassomonas og Colwellia. Bakteriene ble isolert fra TP,
CF og PM, og dette indikerer at disse bakteriene er en del av den normale bakteriefloraen bade
i og pa S. droebachiensis. Til sammenligning fant Unkles (1977) ogsa Vibrio, Pseudomonas og
Acinetobacter hos friske krakeboller av arten Echinus esculentus [118], og Nelson et al. (2010)
fant blant annet Vibrio, Pseudomonas og Shewanella hos friske krakeboller av arten Lytechinus
variegatus [119]. Likevel er flere av bakteriene isolert fra de friske S. droebachiensis
Klassifisert som patogen for enkelte andre marine virvellgse dyr. Blant annet konstaterte Lopez
et al. [120] at en Pseudomonas-art var patogen for kilesal, og Liu et al. [121] konstaterte at art

tilhgrende V. splendidus klade var patogen for Yasso kamskjell.
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Blant de to Vibrio-bakteriene isolert fra friske S. droebachiensis i denne oppgaven, ble én av
bakterieisolatene identifisert som art tilhgrende V. splendidus klade. Siden samtlige arter
tilhgrende V. splendidus klade er allestedsnarveaerende i det marine miljg, var det derfor
forventet & finne noen fa V. splendidus-arter hos de friske krakebollene [66]. Imidlertid ble
krakebollene definert som frisk om de ikke viste synlige symptomer pa overflaten. Dermed kan
en ikke utelukke at isolatet, identifisert som art tilhgrende V. splendidus klade, stammer fra ett
sykt individ uten synlige symptomer. Likevel ble det ikke funnet en dominerende tendens av
bakteriearter tilhgrende V. splendidus klade hos de visuelt friske krakebollene, slik som
rapportert hos krakebollene med skallet krakebollesyndrom i det pagaende doktorgradsprosjekt
til Hira [pers. komm]. Dermed var trolig individet, som V. splendidus-isolaten stammet fra, et
friskt individ. P& grunnlag av dette kan en ikke utelukke tilstedeveerelse av art tilhgrende V.
splendidus klade hos friske S. droebachiensis. Imidlertid er det mulig at arter tilhgrende V.
splendidus klade er opportunistiske bakterier for S. droebachiensis, som vil si at de under
normale forhold ikke forarsaker sykdom. Med andre ord kan en eller flere av artene veere arsak
til infeksjon om den normale bakteriekonsentrasjonen i miljoet gkes, eller eventuelt om viktige

komponenter i infeksjonsforsvaret til krdkebollen svikter.

6.2 Patogene Vibrio-stammer og smitteforsgk

For & studere om S. droebachiensis utvikler sykdomssymptomer ved smitte av bakterier
tilhgrende V. splendidus klade, ble det ved denne oppgaven utfart et eksperimentelt, innledende
smitteforsgk. Friske S. droebachiensis med/uten tilfart sar ble eksponert for enten Vibrio sp.
TLOO06 eller Vibrio sp. CF002, isolert og identifisert som V. splendidus-arter ved det pagaende
doktorgradsprosjektet. Resultatene fra smitteforsgket viste at bare én av totalt 48 krakeboller
smittet med TLOO6 eller CF002 utviklet et distinkt sykdomssymptom (lesjon). Siden
krakebollene benyttet for smitteforsgk ble oppsamlet fra naturen, hadde en ingen forkunnskap
om livshistorien til krakebollene eller hva de tidligere var blitt utsatt for. Det er dermed en
usikkerhet knyttet til hvorfor denne ene krakebollen utviklet lesjon. En forklaring er at
krakebollen var mer utsatt for infeksjon enn de andre krakebollene, pa grunn av for eksempel.
svikt i immunforsvaret. En annen forklaring er at krakebollen allerede far smitteforsgket var
blitt smittet med en annen type agens enn art tilhgrende V. splendidus klade. Imidlertid vokste
det opp bare en type bakterie pa agarskalen med tilfart TP fra krakebollen med lesjon, og denne
bakterien ble identifisert, ved hjelp av 16S rRNA-sekvensering, som art tilhgrende V.
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splendidus klade. Etter avsluttet smitteforsgk mistenkte en derfor at bakterieisolatet fra
krakebollen med lesjon var en re-isolat av Vibrio sp. TLO06. Hvis dette var tilfelle ville Kochs
postulater veere oppfylt, og dermed ville TLO06-bakterieisolatet veert bevist & ha vaert assosiert
med sykdomstegn, eller veert patogen. Selv om dette ville vaere oppfylt, ville det statistiske

grunnlaget for dette ikke veere tilstede, da bare denne ene krakebollen med lesjon ble detektert.

Selv om de fleste krakebollene etter avsluttet smitteforsgk viste en generelt markere overflate
med relativt faerre pigger sammenlignet med krakebollene fra kontrollgruppene, utviklet de ikke
et karakteristisk, distinkt sykdomssymptom. Med andre ord var det ikke mulig & pavise at
mikroorganismene var i stand til & fremkalle lesjon hos forsgksdyrene i lgpet av den tiden
smitteforsgket pagikk. Dermed synes ikke Kochs postulater a vare oppfylt, da grunnlaget for a
antyde at TLOO6 og/eller CFO02 er patogene er for spinkelt. Likevel er dette smitteforsgket
interessant, da det kan gi informasjon om krakeboller og deres mikrobiota. En forklaring pa fa
sykdomstegn er at disse krakebollene hadde et godt immunforsvar som bekjempet infeksjonen,
ved for eksempel. & produsere AMPs. Pa bakgrunn av at det var lite eller ingen bakterievekst
pa flere agarskaler med ramateriale fra krakebollene utsatt for smitteagens, styrkes denne
pastanden. Dette fordi stor produksjon av AMPs sannsynligvis vil fare til liten tilstedeverelse
av bakterier generelt [122]. I tillegg er det tenkelig at krake-bollene ble syke pa en slik mate at
symptomer ikke var godt synlige og dermed vanskelig & fa gye pa. Det er derfor mulig at
krakebollene ville utviklet lesjoner pa overflaten om smitteforsgket hadde pagatt over lengre
tid.

Parametere som for eksempel. bakteriekonsentrasjon, eksponeringstid, vannsirkulasjon,
temperatur og smittemetode, er ogsa faktorer som kan ha pavirket sykdomsutviklingen og
lesjonsdannelsen hos krakebollene. | denne oppgaven ble det valgt «badsmitte», da en gnsket &
tilsette bakteriene mest mulig skansomt, samt a sa neer som mulig imitere en «naturlig»
smitteprosess. Det finnes fa eksempler pa smitteforsgk med krakeboller i litteraturen, men et
eksempel med badsmitte er studien til Tajima et al. [123]. De utfarte smitteforsgk pa arten S.
intermedius ved 20 °C, 23 °C og 25 °C, der de utsatte krakebollen for 10%, 10° og 10° cfu/ml av
et isolat tilhgrende familien Cytophagaceae. Etter 10 dager var ingen av krakebollene utsatt for
smitte ved 20 °C dad, men alle krakebollene utsatt for smitte ved 25 °C dade etter 3 dager. De
krakebollene utsatt for 10° cfu/ml ved 25 °C dgde innen 24 timer etter smitte. Med andre ord
kunne Tajima et al. rapportere at temperatur og bakteriekonsentrasjon hadde innvirkning pa

sykdom og deretter dgd hos krake-bollearten S. intermedius. Denne konklusjonen kan
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sammensettes med studien til Hernroth [124], hvor pavirkningen av temperatur og LPS-dose
for produksjon av AMPs i muslingen Mytilus edulis ble studert. Hernroth konkluderte med at
produksjonen av AMPs gkte raskere ved hgyere temperaturer og stgrre doser enn ved lave
temperaturer og sma doser. Dette kan dermed bety at en organisme far en raskere og sterre
infeksjon om dosen med smitteagens er stor og temperaturen i miljget er hgy. | smitteforsgket
ved denne oppgaven ble S. droebachiensis utsatt for en dose pa ca. 10°%-107 cfu/ml ved ca. 12
°C. Dermed ble S. droebachiensis utsatt for en relativt stor dose smitteagens, men ved en lav
temperatur, sammenlignet med Tajima et al. sitt smitteforsgk pa S. intermedius [123].
Temperaturen ved smitteforsgket var derfor mulig ikke hay nok for a gi en starre infeksjon hos
S. droebachiensis. Likevel var opprinnelsen til krakebollene med lesjoner, som TL006 og
CF002 var isolert fra, fra et oppdrettsanlegg hvor temperaturen var lik den arktiske
havtemperaturen (4 - 12 °C) [Stensvag pers. komm]. Dette vil si at krakebollene i smitteforsgket

ble utsatt for smitteagens ved en tilnaermet «naturlig» temperatur for arten S. droebachiensis.

Et annet eksempel pa et smitteforsgk utfart pa krakeboller er studien til Bauer og Young [49].
| denne studien ble krakebollearten P. cristatus injisert med bakteriesuspensjon istedenfor
eksponering ved «badsmitte», slik som krakebollene i denne oppgaven. Resultatene deres etter
utfert smitteforsgk indikerte at bakterien V. alginolyticus forarsaket sykdomssymptom og
deretter dgd, men da bare ved en massiv coelominfeksjon. Imidlertid ble smitteforsgket utfart
uten vannsirkulasjon/vannutskiftning, samt med svert fa individer i hver gruppe (4 stk.). |
tillegg ble det ikke utfart LD50-testing, som vil si at studien ikke hadde gode betingelser for a
si noe om hvor stort smittepress som behgvdes for a gi 50% dgdelighet. Likevel ga den grunnlag
for spersmal om coelomvasken til S. droebachiensis ogsa ma inneholde en relativt stor
bakteriekonsentrasjon av TLO06 eller CF002 for at krakebollene skal utvikle karakteristiske
lesjoner. Ved et reelt, nytt smitteforsgk kan en derfor vurdere om krakebollene skal injiseres
med bakteriesuspensjon, med tanke pa direkte smitte med stor bakteriedose. Eventuelt kan en
vurdere om bakteriekonsentrasjon og eksponeringstid skal gkes ved badsmitte. Det mest
gnskelige ber vaere a velge parametere som ligner et naturlig miljeg, for & kunne konstatere at en
art tilhgrende V. splendidus klade er patogen for S. droebachiensis. | tillegg trengs gruppe-
paralleller med relativt mange individer, for a utfgre gode statistiske tester som kan pavise
signifikans mellom kontrollindividene og smittede individer, samt sikre at resultatet i

smitteforsgket kan verifiseres i flere forsgk slik at det holder standard for vitenskapelig arbeid.
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For a konkludere kan en ut ifra det eksperimentelle smitteforsgket som ble foretatt i denne
oppgaven ikke bekrefte eller utelukke at Vibrio sp. TLOO6 eller -CF002 er patogen for
krakebollearten S. droebachiensis. Dermed kan ikke hypotesen, om at bakteriearter tilhgrende
V. splendidus klade kan assosieres med symptomer karakterisert som skallet krakebolle-
syndrom hos arten S. droebachiensis, verifiseres. Et nytt smitteforsgk med endrede betingelser
ma derfor utfares for & kunne verifisere eller forkaste hypotesen. Endringene ber ha fokus pa et

starre smittepress eller endring av betingelser for inkubasjon.

6.3 Metodikk for identifikasjon og karakterisering av Vibrio-stammer

Identifiseringen av bakteriene isolert fra de visuelt friske, granne krakebollene og krakebollene
som deltok i smitteforsgket, ble utfert ved hjelp av sekvensering av 16S rRNA-genet til
bakteriene. Til sammen ble det identifisert 57 isolater, der 7 var Vibrio-bakterier. Blant annet
fordi 16S rRNA-sekvensering er en relativt kostbar og tidkrevende metode, ble bare dyrkbare
bakterier med lignende morfologi som Vibrio sp. selektert ut for isolering og identifisering.
Dette vil si at blant mange bakterier funnet hos S. droebachiensis, ble bare noen fa bakterier
identifisert. PA den ene siden var det akseptabelt & selektere ut enkelte bakterier, da Vibrio-
bakterier var fokus og en malrettet var ute etter a finne arter tilhgrende V. splendidus klade. Pa
den andre siden kunne dette medfare stgrre sannsynlighet for tap av funn av noen Vibrio sp.,
samt at en ikke fikk hele oversikten over mikrobiotaen hos S. droebachiensis. I tillegg viste 16S
rRNA-sekvenseringen seg uegnet til & verifisere om isolatene isolert fra de friske, granne
krakebollene og krakebollene som deltok i smitteforsgket var av samme art eller stamme som
isolatene isolert fra syke S. droebachiensis ved pagaende doktorgradsprosjekt. Like fult kunne
ikke metoden konkret identifisere og skille isolatene Vibrio sp. TL002, -TL0O03, -TL0O06, -
CFO001, og -CF002, isolert fra syke S. droebachiensis ved pagaende doktorgradsprosjekt.
Grunnen til dette er at samtlige av bakterieisolatenes 16S rRNA-gen viser stor sekvenslikhet
med 16S rRNA-genet hos flere ulike arter fra V. splendidus klade i NCBI-databasen.

Problemet med identifisering og klassifisering av arter tilhgrende V. splendidus klade er ogsa
rapportert om i studien til Pérez-Catalufia et al. [65]. | denne studien identifiserte de arter
tilhgrende V. splendidus klade, bade ved hjelp av sekvensering av 16S rRNA-, recA-, gyrB-,
mreB-, rpoD- og pyrH-genet. Resultatene deres etter utfert studie viste at sekvensering av flere
ulike genetiske markarer kan benyttes for a artsbestemme bakterier innenfor V. splendidus

kladen. Likevel evaluerte de tilneermingen som darlig for identifikasjon av enkelte arter, da de
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for eksempel hadde problemer med 4 identifisere og klassifisere artene V. tasmaniensis og V.
atlanticus [65]. | denne oppgaven ble det utfart sekvensering av de genetiske markarene 16S
rRNA og recA pa isolatene Vibrio sp. TL002, -TL003, -TL006, -CF001 og -CF002, samt pa
isolatet SUA-TP-AL fra krakebollen med lesjon etter utfgrt smitteforsgk. Resultatene fra
sekvenseringen ga, til forskjell i fra sekvensering med mange genetiske markarer, sveert darlig
indikasjon pa hvilken Vibrio-art isolatene tilhgrte. Dette var forventet, da det er kjent i
litteraturen at det er stor sekvenslikheten i flere genetiske markarer, som for eksempel 16S
rRNA og recA, mellom flere av artene i slekten Vibrio [91, 92, 94].

Siden sekvensering av genetiske markgrer for identifikasjon av dyrkbare marine bakterier viste
seg a veare en svert tidkrevende og kosthar metode, i tillegg til at den ikke var optimal for a
identifisere enkelte bakterier pa artsniva, ble det ved denne oppgaven vurdert andre metoder for
identifisering. Da det er rapportert at MALDI-TOF MS er en enkel, hurtig og lite kostbar
metode som kan identifisere bakterier ned pa bade art- og stammeniva, ble metoden ansett som
en mulig metode for identifikasjon av Vibrio-stammer fra S. droebachiensis [110, 112]. Ved
analysering av isolatene Vibrio sp. TL002, -TL003, -TL006, -CF001, -CF002 og SUA-TP-AL,
med bruk av den kommersielle databasen til Bruker Daltonics for identifikasjon, ble isolatene
TLOO3 og CFO002 identifisert som V. tasmaniensis og isolatene TLO06 og SUA-TP-A1 ble
identifisert som mulig arten V. tasmaniensis. Isolatene TL002 og CF001 kunne derimot ikke
identifiseres. Med andre ord hadde denne kommersielle databasen en begrensning i forhold til
innhold av referansespekter fra marine bakterier. Dette er ogsa rapportert om av Emami et al.
[114], hvor de benyttet MALDI-TOF MS for identifikasjon av marine bakterier i ballastvann.
De konkluderte med at metoden hadde problemer med a identifisere spesielt Vibrio-bakterier
pa artsniva. Ved denne oppgaven ble det derfor utviklet en egen database for marine bakterier
med innhold av referansespekter fra isolatene Vibrio sp. TL002, -TL003, -TL006, -CF001 og -
CF002.

Begrunnelsen for & utvikle en MALDI-TOF MS database for Vibrio-isolatene isolert ved det
pagaende doktorgradsprosjektet, var at en med bruk av den lettere kunne identifisere eller si om
ukjente bakterier er av samme art og stamme som en av isolatene i databasen. Ved et
smitteforsgk vil dette veere nyttig, da en enkelt kan fa informasjon om en har re-isolert et
bestemt isolat. Ved denne oppgaven ble isolatet SUA-TP-AL, isolert fra krakebollen med lesjon
fra eksperimentelt, innledende smitteforsgk, analysert med benyttelse av egenprodusert

database. Dette for & studere om SUA-TP-AL var en re-isolat av TL0O06, slik som en mistenkte
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etter utfart smitteforsgk. Analyseresultatene etter utfgrt MALDI-TOF MS viste derimot at SUA-
TP-A1 ble identifisert som TLO03. Imidlertid er det mulig at bade SUA-TP-A1, TL003 og
TLOO6 er sveert lik i utgangspunktet, da det ble vist at de alle tre har svaert lik morfologi,
sekvenslikhet av genetiske markarer og like spekter. Begrunnelsen for at de ikke har identiske
spekter, kan veere at intensiteten pa toppene til en prgve kan variere noe for hver gang prgven
analyseres. Dette ble for eksempel sett ved referansebakterienes biologiske og tekniske
spekterreplikaer i databasen. Videre undersgkelse av isolatene ber likevel foretas for a studere

om de faktisk er av «<samme stamme».

I helt nyere tid har Machado et al. [125] oppdaget en genetisk markar kalt «fur». Dette genet
koder for regulering av jernopptak hos bakterier, og Machado pastar at dette genet alene kan
benyttes for & identifisere bakterier fra familien Vibrionaceae pa artsniva. Dermed kan fur-
sekvensering, eventuelt i kombinasjon med MALDI-TOF MS, i fremtiden vere et alternativ
for identifikasjon av arter tilhgrende V. splendidus klade isolert fra friske og syke S.
droebachiensis. Sammenlignet med MALDI-TOF MS, er likevel gensekvensering per i dag en
mer tidkrevende og kostbar analysemetode for identifikasjon av bakterier, men tilneermingen
kan i noen tilfeller gi mer informasjon om bakterien. Ved helgenomsekvensering for eksempel
far en informasjon om hele genomet til en bakterie, og dermed ogsa gener som koder for
proteinsammensetningen i en bakterie [103].

Ved denne oppgaven ble helgenomsekvensene til bakterieisolatene Vibrio sp. TL006 og -CF002
benyttet. Sekvensene ble benyttet bade for & gi identifikasjon av art, samt til & identifisere
enkelte virulensgener hos stammene. Resultatene viste at begge isolatene ble identifisert som
arten V. tasmaniensis. Dette samsvarer med resultatet fatt vad analysering pa MALDI-TOF-
MS. Arten er av blant andre Pérez-Catalufia et al. [65] og Machado et al. [125] rapportert om
som en art som svert ofte blir identifisert som arten V. splendidus. Imidlertid gir
nukleotidsekvensen av hele genomet nok informasjon til korrekt identifikasjon av art, i tillegg
til informasjon om virulensgener. Virulensgenene OmpU og vsm ble blant annet identifisert
hos bade Vibrio sp. TL0O06, og -CF002. OmpU-proteinet er rapportert a utgjere en stor
virulensfaktor blant Vibrio-stammer, og da serlig blant V. splendidus-relaterte arter [126]. |
tillegg er det vist at proteinet spiller en aktiv rolle i vert-patogen-interaksjoner, tjener som
adhesjonsprotein [127], og er involvert i resistansen mot antimikrobielle peptider [128].
Metalloproteasen vsm er rapportert som den viktigste toksiske faktoren i ekstracelluleere

produkter hos enkelte arter tilhgrende V. splendidus klade [129]. Genet for dette proteinet, samt
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flagell- og hemolyse-gener, ble ogsa identifisert blant genomene til isolatene. Gener som koder
for flagell og hemolytisk aktivitet var forventet a finne, da resultater fra hemolyse-test og SEM

viste at isolatene var p-hemolytisk og hadde flagell.

Funn av virulensgener som koder for OmpU, vsm, flagell og hemolytisk aktivitet hos isolatene
TL006 og CF002, kan veere med a styrke pastanden om at disse stammene er patogen for S.
droebachiensis. Likevel bgr videre analyse av flere virulensgener i genomet til isolatene
utfares. I tillegg ber det dokumenteres hvilken effekt virulensfaktorene har hos krakeboller, for

en eventuelt kan konkludere om disse to stammene er patogen for S. droebachiensis.
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7 Konklusjon
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Undersgkelser i denne oppgaven viser at i mikrobiotaen hos bade friske, grgnne
krakeboller (S. droebachiensis) og krakebolleindivid med symptomer pa skallet
krakebolle-syndrom, inneholder bakterier tilhgrende V. splendidus klade.

Et eksperimentelt, lite smitteforsgk gav oppvekst av én bakterietype hos ett individ med
lesjon i de eksperimentelle gruppene. Dette resultatet kan ikke benyttes til & verifisere
om isolatene isolert fra syke individ, og som var benyttet i smitteforsgket, var patogen
for den grenne krakebollen.

En rekke dyrkbare bakterier, ogsa Vibrio-bakterier, ble isolert fra syke krakeboller.
PCR teknologi og sekvensering av 16S rRNA- og recA-gener kunne ikke skille disse
Vibrio-bakteriene fra hverandre og peke pa noen oppdyrkede Vibrio-stammer som mer
patogen enn andre.

En MALDI-TOF MS database for marine Vibrio-bakterier ble etablert, og gjorde det
mulig pa kort tid & analysere og identifisere likhet for oppdyrkede Vibrio-lignende
kolonier med dem i databasen.

Helgenomsekvensdata pa to av de V. splendidus-relaterte-isolatene isolert fra syke
krakeboller, ble identifisert som bakteriearten V. tasmaniensis. I tillegg ble gener som
koder for virulensfaktorer som OmpU, vsm, flagell og hemolytisk aktivitet pavist hos
disse bakterie-isolatene.

Analyser basert pa gensekvenser, som 16S rRNA, er for updlitelig for a identifisere
bakterier tilhgrende V. splendidus klade, mens ngyaktige helgenomanalyser er for dyre
og tidkrevende. Bruk av MALDI-TOF MS pa marine bakterier vil vere hurtig og
billig, men krever en godt etablert database.

Arbeidshypotesen om at bakteriearter innenfor V. splendidus- klade kan assosieres med
symptomer som karakteriseres som skallet krakebollesyndrom hos arten S.
droebachiensis, kan ikke verifiseres ved denne oppgaven. Nye smitteforsgk med

endrede betingelser ma foretas for a kunne trekke en klar konklusjon pa hypotesen.
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9 Appendiks 1

1.1  MALDI Biotyper Realtime Classification (RTC)

Currently, biochemical tests form the basis of most techniques used to identify
microorganisms. Reagents that are metabolized only by specific organisms are added to
cultures. This leads, for example, to a characteristic color change of the added reagent,
which can then be compared with reference values. Correlating the results of a number of
such tests on a sample culture provides an indication of the organism's identity.

1.1.1 Identifying Microorganisms using Mass Spectrometry

The MALDI Biotyper uses a different methodology: it identifies microorganisms by
analyzing the expression of their intrinsic proteins using mass spectrometry. This mass
spectral pattern of protein expression is compared with reference patterns in a database
(alist of the entries contained in the reference database can be obtained on request).

Starting material for a classification using the MALDI Biotyper is an individual colony from

an overnight culture on an agar plate. The sample is transferred to a position on a MALDI
target and air-dried.

After drying, a small quantity of matrix solution is added. The organic solvent in the matrix
solution extracts proteins from the microorganisms. The extracted proteins are mainly
ribosomal proteins, which are present in high concentrations.

Once the matrix has crystallized, sample preparation is complete and the samples can be
analyses.



If this straightforward sample preparation method is unsuccessful, a supplementary
protocol containing short chemical extraction steps can be used to increase the range of
organisms that can be identified by MALDI analysis.

MALDI (matrix- assisted laser desorption/ionization) TOF (Time of Flight) mass
spectrometry forms the basis of MALDI Biotyper analyses. A laser in the MALDI-TOF
mass spectrometer irradiates the matrix/sample mixture, evaporating the matrix and
releasing positively charged proteins in a so-called “soft” ionization process. The ability of

the matrix to absorb UV light and transfer protons onto the extracted proteins is crucial to
this process.

The protein ions are electrostatically accelerated over a short distance and arrive in the
flight tube at a speed that is proportional to their mass. Protein ions with different masses
arrive at the detector after different time periods. Simply by measuring the time between
pulsed acceleration and the corresponding detector signal (in the nanosecond range), the

speed of the ions can be measured very precisely and converted into an accurate
molecular mass.

12 Generating a 'Molecular Fingerprint’

MALDI Biotyper analysis generatés a characteristic mass and intensity distribution of the
mainly ribosomal proteins. Because this mass spectrum is species-specific for a large
number of microorganisms, it represents a ‘'molecular fingerprint'. Unknown

microorganisms can be identified by comparing their ‘fingerprint' with the thousands of
patternsin the reference database.

The first step of data processing is transferring acquired mass spectra into peak lists. In a
second step, these peak lists are compared with every pattern in the reference database.

1.1.3 Calculating a Score Value

The matching algorithm used to compare patterns computes three separate values for
three fundamental characteristics of the sample and the reference spectra.

1. First, the number of signals in the reference spectrum that have a closely matching

partner in the unknown spectrum are calculated. No matches returns a value =0 and a
complete match returns a value = 1.

2. Then, the number of signals in the unknown spectrum that have a closely matching
partner in the reference spectrum are determined. No matches returns a value = 0 and
a complete match returns a value = 1.



3. Finally, the symmetry of the matching signal pairs is computed. If the high-intensity
signals of the unknown spectrum correspond with the high-intensity signals of the
reference spectrum and the low-intensity signals also correspond, this results in high
symmetry value and the so-called correlation matrix yields a value close to 1. If the
matching pairs of signals show no symmetry at all, this results in a value close to 0.

These three values are multiplied together and the result is normalized to 1000. The score

value is the common (decadic) logarithm of this result. The maximum obtainable score
value is 3 (= log 1000).

Subsequent ranking of the score values puts the best match at the top of the list. The
higher the score value, the more probable the classification of the species. A color-coded
display of the score value enables rapid evaluation of the results.

Score values = 2.0 can be considered as a probable classification.
It is important to realize that a score value generated by MALDI Biotyper RTC

represents a probability that the unknown microorganism is a species in the
MALDI Biotyper database.

3.3 MALDI Biotyper OC Workflows

The MALDI Biotyper can be used to:

o Classify unknown organisms using:
o Raw spectra or MSPs (see section 3.4)
o Composite Correlation Index matrices (see section 3.8.3)

Refine classifications of closely-related organisms using subtyping MSPs (see
section 3.4.4)

Organize spectra from characterized organisms into taxonomy trees and MSP
libraries (see section 3.5)

Investigate relationships between microorganisms using:
o PCA dendrograms and Scores and Loadings tables (see section 3.7)
o MSP dendrograms (see section 3.6)
o CCI matrices (see section 3.8.1)

3.31 Raw Spectra and MSPs

The basic input for MALDI Biotyper workflows is raw spectra, either from unknown or

characterized microorganisms. Before being preprocessed, raw spectra must be selected
and loaded into the MALDI Biotyper program (see section 3.3.2)

Preprocessing methods (see section 3.3.4) control the transformation of raw spectra into
peak lists. Further processing methods (see section 3.3.3) control the transformation of
the generated peak lists and the algorithms used to generate results.

Some MALDI Biotyper processes require MSPs as a starting point. MSPs are created
from raw spectra using a standard preprocessing method and an MSP creation method.

Once created, MSPs are stored in the database and are managed in the Table View (see
section 3.2.5).
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Figure 3-2 MALDI Biotyper offline classification processing schema
3.3.2 Loading Spectra and MSPs into the File View
3321 Handling Spectra

Before being processed (for example in MSP creation or PCA clustering) raw spectrum
files must be loaded into the File View using the Spectrum Browser.



Using the Spectrum Browser
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Figure 3-3 MALDI Biotyper Spectrum Browser
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The Spectrum Browser displays a tree containing all spectra in and below the selected
Root folder that meet the selected filter criteria. '

By default, folder nodes are collapsed and cleared. Click @ to expand folders. Select the
box next to the folder name to enable spectrum import.

Click Select All to select all boxes in the tree. Click Clear Selection to clear all boxes.



Filtering Spectra

Selecting options in the Filter Spectra area of the Spectrum Browser enables spectra to
be filtered according to:

« type (MS, LIFT, LIFT (converted), FAST, FAST Segment, Unknown) and/or
« date of acquisition (From, To).

Selecting/clearing a spectrum type option automatically updates the spectrum tree.
To apply date of acquisition filtering, select the desired folder and click Apply.

By default, all spectrum types are selected and date filters are cleared, i.e. no filtering
occurs.

The Spectrum Properties area displays the properties of the spectrum currently
selected in the spectrum tree.

Selected spectra displays the number of spectra selected in the spectrum tree.

Spectra displays the number of filtered spectra listed in the spectrum tree followed by the
total number of spectra contained in the selected folder.

» > To load spectra into the File View
1. Launch the Spectrum Browser window by select File > Add Spectra or clicking 0 4.
2. Click Browse, navigate to the desired spectrum file folder and click OK.

Folders and subfolders containing spectra will appear in the main body of the window.
Use the filters to narrow searches.

[an

3. Select the folder(s) containing the desired spectra and click Open to load them into the
File View.

Click Select All to select all boxes in the tree.Clear Selection to clear all boxes.
» » To remove spectra from the File View

1. Highlight the unwanted spectra.
2.

Right-click the highlighted spectra and select Remove Selected Spectra from the
shortcut menu.

3. Toremove all spectra from the File View, select File > Clear All Spectraorclick | z.

3.3.2.2 Loading Spectra from MALDI Biotyper RTC Projects

Spectra from MALDI Biotyper RTC projects can be directly Ioadefi into MALDI Biotyper for
further analysis or processing (e.g. PCA, subtyping or MSP creation).



» » To load a MALDI Biotyper RTC Project

1. Select Action > Open Realtime Classification Project.

The Load Project dialog opens.

e

% | oad Project

__EER)

Name Creation Date
2010-10-01-kok 02 01.10.2010:11:10:09
2010-10-01kok03 01.10.201011:24:35 i
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[ ok ] [ cancel | [ Hep |

Figure 3-5 Load Project dialog
2. Select the desired project and click OK.

The spectra files in the project are loaded into the File View Spectrum tab. The raw

spectrum and the classification results of the currently highlighted spectrum are
displayed in the Spectrum View and Spectrum Scores table respectively.
Note

This feature requires that the raw spectra files are available on the local
computer.

3.3.23 Handling MSPs

MSPs can be added to the File View MSP page for classification.
» » To load MSPs into the File View

1. Move the desired MSPs into the Current MSP or Selected MSP table.

2. Highlight and right-click the MSPs and select Add MSPs for Identification from the
shortcut menu.

» » To remove MSPs from the File View

1. Highlight and right-click the unwanted MSPs and select Remove Selected MSPs
from the shortcut menu.

To remove all MSPs from the File View, select File > Clear All MSPs or click - x.

it
i



33.24

Selecting Spectra and MSPs for Processing

» » To highlight spectra and MSPs for processing

For some workflows (manual preprocessing, classification, MSP creation), spectra
I MSPs must be highlighted in the File View before processing.

3.33

To highlight a single spectrum / MSP, click it with the left mouse button.

To highlight multiple consecutive spectra / MSPs, hold down the Shift key and click
the first and last member of the series.

To highlight multiple non-consecutive spectra / MSPs, hold down the Ctrl key and
click the desired spectra/ MSPs.

Highlighted spectra/ MSPs have a blue background.

Creating, Editing and Selecting Proceséing Methods

MALDI Biotyper workflows are controlled by processing methods.

3.3.3.1

Preprocessing Methods — used to generate peak lists from raw spectra.

MSP |dentification Methods — used to identify the sample from which the spectrum
was obtained. :

MSP Creation Methods — used to create an MSP from selected spectra.
Subtyping MSP Creation Methods — used to create subtyping MSPs from an MSP

PCA Creation Methods — used to perform principal component analysis on
preprocessed spectra.

PCA Clustering Methods — used to cluster preprocessed spectra based on the
result of the PCA.

MSP Dendrogram Creation Methods — used to create a dendrogram from selected
MSPs.
Composite Correlation Index Methods — used to calculate a CCI matrix.

The MALDI Biotyper Method Editor

TheMALDI Biotyper Method Editor enables users to view, create and edit processing

methods. The editor is launched by selecting Edit > Method > [method type] or Action
> [method type] > Edit Method from the respective top-level menu.
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Figure 3-6 MALDI Biotyper Method Editor

The currently active method is displayed in the Method Name field. Each installation of
the MALDI Biotyper software contains a read-only default parameter set for each process
(Biotyper [method type] Standard Method).

The editor also displays an optional Description and the method's unique Method ID and
Method Version which cannot be changed.

The main body of the editor displays the parameters and current settings for the respective
method type.

» > To view currently active processing methods and their parameters

1. Select Edit > Method > [method type] to launch the MALDI Biotyper Method Editor.

The currently active method and its parameters are displayed.

2. Click OK to close the MALDI Biotyper Method Editor.



Table 3-1 MALDI Biotyper processing methods

Method Type Input Output
Preprocessing Raw spectra Peak lists
MSP Identification Raw spectra or MSPs Classification of
microorganism
MSP Creation Peak lists of preprocessed | MSP (reference
spectra spectrum)
Subtyping MSP Creation MSPs Subtyping MSPs
PCA Creation Preprocessed spectra Principal Component
Analysis
PCA Clustering Preprocessed spectra + PCA cluster diagram
PCA
MSP Dendrogram Creation MSPs MSP dendrogram
Composite Correlation Index Preprocessed spectra CClI matrix
Calculation
3332 Creating and Editing Custom Processing Methods

Custom processing methods are created by editing a copy of a default method and saving
it under a different name.
» > To create a custom processing method

1. Select Edit > Method > [method type] to launch the MALDI Biotyper Method Editor.

Optional: ~ Enter a description of the new method in the Description input field.

2. Adjust the parameters as desired.

Note Preprocessing method parameters are divided into groups (Mass
Adjustment, Smoothing, etc.). The currently displayed group is indicated by
agray arrow v

Click Save As and enter a new Method Name into the Insert New [method type]

Method Name dialog.

The method will be saved with a new Method ID and Method Version number.




4. Click OK to close the MALDI Biotyper Method Editor and make the new method active

The new method will be active until a different method is selected from the Method
Name drop-down list and OK is clicked.

» » To edit a custom processing method

Select Edit > Method > [method type] to launch the MALDI Biotyper Method Editor.
Select the method to be edited from the Method Name drop-down list.

Adjust the parameters as desired.

Click Save.

~ N~

The method is saved under the same Method Name with a new Method ID.

Click OK to close the MALDI Biotyper Method Editor and make the edited method
active.

3333 Selecting Processing Methods

» » To select a processing method

i
2.
3.

Select Edit > Method > [method type] to launch the MALDI Biotyper Method Editor.
Select the desired method from the Method Name drop-down list.

Click OK to close the MALDI Biotyper Method Editor and make the chosen method
active.

3.34 Preprocessing Spectra

Preprocessing methods are used to generate peak lists from raw spectra. Because the

amount of information required for each workflow is different, preprocessing methods can
be optimized to speed up analysis and reduce data set size.

3.341 Default Preprocessing Methods

Each installation of the MALDI Biotyper software contains three read-only preprocessing

methods for use during the classification, MSP creation, PCA clustering and CCI
calculation workflows.



3.3.4.2

Custom Preprocessing Methods

Users can develop custom preprocessing methods by stepwise optimization of the

individual preprocessing method parameters listed on the Preprocessing page of the
MALDI Biotyper Method Editor.

» » To create a custom preprocessing method

;8

Select Edit > Method > Preprocessing to launch the MALDI Biotyper Method
Editor.

Optional:  Enter a description of the new method in the Description input field.

Adjust the parameters as desired.

Preprocessing method parameters are divided into groups. The currently displayed
parameter group is indicated by a gray arrow o

Click Save As and enter a new Method Name into the Insert New Preprocessing
Method Name dialog.

The method will be saved with a new Method ID and Method Version number.

Click OK to close the MALDI Biotyper Method Editor and make the new method active.

The new method will be active until a different method is selected from the Method
Name drop-down list and OK is clicked.

Mass Adjustment

The Mass Adjustment parameters define whether and how to adjust masses in spectra
during preprocessing.



Smoothing

The Smoothing parameters define whether and how to smooth spectra during
preprocessing. MALDI Biotyper supports the Savistsky-Golay smoothing method.

Baseline Subtraction

The Baseline Subtraction parameters define whether and how to perform baseline

subtraction on spectra during preprocessing. MALDI Biotyper supports the Multipolygon,
Minimum, Penalized least squares and Penalized B-Spline baseline subtraction methods.

Normalization

The Normalization parameters define how to normalize spectra during preprocessing.
MALDI Biotyper supports the Maximum Norm and P-Norm normalization methods.

Peak Picking

The Peak Picking parameters define how to pick peaks on spectra during preprocessing.

MALDI Biotyper supports the Spectra Differentiation, Peak Fitting and Local Maximum
peak picking methods.

» » To check the effect of a preprocessing method on raw spectra

The optimization can be checked using commands in the Action > Preprocessing

menu. Selecting these commands applies the respective active parameters to raw spectra
and displays the resulting processed spectra in the Spectrum View.

1. Load and highlight the desired spectra (see section 3.3.2.2).
The highlighted spectra are displayed in blue in the Spectrum View.

Select Edit > Method > Preprocessing.Select the desired method from the Method
Name drop-down list in the MALDI Biotyper Method Editor and click OK.
3. Check the effect of the individual parameter settings by:

a. Selecting Action > Preprocessing > Adjust Mass.

The mass-adjusted spectrum is generated for all highlighted spectra and displayed in
orange overlaid on the raw spectrum.

b. Selecting Action > Preprocessing > Smooth.



The mass-adjusted, smoothed spectrum is generated for all selected spectra and is
displayed in purple overlaid on the raw spectrum.

c. Selecting Action > Preprocessing > Subtract Baseline.

The mass-adjusted, smoothed, baseline-subtracted spectrum is generated forv all
selected spectra and is displayed in cyan overlaid on the raw spectrum.

d. Selecting Preprocessing > Normalize.

The mass- adjusted, smoothed, baseline- subtracted, normalized spectrum is
generated for all selected spectra and is displayed in green in the Spectrum View.

e. Selecting Action > Preprocessing > Pick Peaks.

The peak picking resultis generated for all selected spectra and displayed in red using
an inverted intensity scale below the preprocessed spectrum.

f. Selecting Action > Preprocessing > Batch Processing.

The steps a— e above can be performed using a single command. Batch Processing
generates the peak picking result for all selected spectra.



